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File	Explorer	is	an	essential	tool	in	Windows.	It	helps	you	manage	your	files	and	folders.	This	guide	provides	comprehensive	details	on	how	to	get	help	with	File	Explorer	in	Windows,	from	how	to	use	it	to	solving	common	problems.You	have	many	ways	to	open	File	Explorer	in	Windows.	Choose	the	method	that	you	find	easiest.Click	the	Search	icon	or
Search	bar	on	your	taskbar.Type	“File	Explorer“.Select	File	Explorer	from	the	search	results.Right-click	the	Start	button	on	the	taskbar.Select	“File	Explorer”	from	the	menu	that	appears.Look	for	the	File	Explorer	icon	on	your	taskbar.	It	looks	like	a	yellow	folder.Click	the	File	Explorer	icon	to	open	it.If	it	is	not	pinned,	you	can	search	for	it	and	then
right-click	to	“Pin	to	taskbar“.Press	the	Windows	key	+	X	on	your	keyboard.This	action	opens	the	Quick	Link	menu.Select	“File	Explorer”	from	this	menu.Click	the	Start	button.Look	for	the	File	Explorer	icon	in	the	left	pane	of	the	Start	menu.Click	the	icon	to	open	File	Explorer.You	might	need	to	customize	your	Start	menu	to	show	this	icon.Press	the
Windows	key	on	your	keyboard	to	open	Start.Start	typing	“File	Explorer“.The	search	results	will	show	File	Explorer.	Click	it.Press	the	Windows	key	+	R	to	open	the	Run	dialog	box.Type	“explorer.exe”	in	the	box.Click	“OK”	or	press	Enter.Open	the	Run	dialog	box	(Windows	key	+	R).Type	C:\Windows\explorer.exe	and	press	Enter.This	directly	runs	the
File	Explorer	application	from	its	location.Open	Command	Prompt.	You	can	search	“cmd”	in	the	Start	menu.In	the	Command	Prompt	window,	type	explorer.exe.Press	Enter.Open	PowerShell.	You	can	search	“powershell”	in	the	Start	menu.In	the	PowerShell	window,	type	explorer.Press	Enter.File	Explorer	uses	a	ribbon	interface	at	the	top	of	its
window.	This	ribbon	contains	common	commands	grouped	into	tabs.The	Home	ribbon	gives	you	access	to	frequent	tasks:Clipboard:	Copy,	paste,	cut,	and	copy	path.Organize:	Move	to,	copy	to,	delete,	and	rename	files	or	folders.New:	Create	new	folders,	shortcuts,	or	various	file	types.Open:	Open	files,	edit	files,	or	view	properties.Select:	Select	all,
select	none,	or	invert	selection.The	Share	ribbon	helps	you	share	files	and	folders:Send:	Email	selected	items,	zip	selected	items,	or	burn	to	disc.Share	with:	Share	files	with	specific	people	or	apps.Advanced	security:	Access	advanced	sharing	and	security	settings.The	View	ribbon	lets	you	change	how	files	and	folders	appear:Panes:	Show	or	hide	the
preview	pane,	details	pane,	or	navigation	pane.Layout:	Choose	icons	(extra	large,	large,	medium,	small),	list,	details,	tiles,	or	content	view.Current	view:	Sort	by,	group	by,	add	columns,	or	size	columns	to	fit.Show/hide:	Toggle	item	check	boxes,	file	name	extensions,	hidden	items,	and	selected	items.Options:	Open	Folder	Options	for	more
settings.Keyboard	shortcuts	can	speed	up	your	work	in	File	Explorer.	Here	are	some	useful	ones:Alt	+	P:	Show/hide	the	Preview	Pane.Ctrl	+	N:	Open	a	new	File	Explorer	window.Ctrl	+	W:	Close	the	current	File	Explorer	window.Ctrl	+	E	or	Ctrl	+	F:	Select	the	search	box.Ctrl	+	Shift	+	N:	Create	a	new	folder.Alt	+	Left	Arrow:	Go	to	the	previous
folder.Alt	+	Right	Arrow:	Go	to	the	next	folder.Alt	+	Up	Arrow:	Go	to	the	parent	folder.F2:	Rename	the	selected	item.F11:	Toggle	full-screen	mode.Quick	access	shows	your	frequently	used	folders	and	recent	files.	You	can	customize	it.Open	File	Explorer.Find	the	folder	you	want	to	pin.Right-click	the	folder.Select	“Pin	to	Quick	access.”	The	folder	will
now	appear	in	the	Quick	access	list.Open	File	Explorer.In	the	Quick	access	list,	find	the	item	you	want	to	unpin.Right-click	the	pinned	item.Select	“Unpin	from	Quick	access.”Open	File	Explorer.Click	the	“…”	tab	on	the	ribbon.Click	“Options”	(it	might	be	an	icon	or	text	on	the	far	right).In	the	Folder	Options	window,	under	the	“General”	tab,	find	the
“Privacy”	section.Uncheck	“Show	recently	used	files	in	Quick	access.”Uncheck	“Show	frequently	used	folders	in	Quick	access.”Click	“Clear”	next	to	“Clear	File	Explorer	history”	to	remove	current	items.Click	“Apply”	then	“OK.”Your	“Documents”	folder	is	a	common	place	to	store	personal	files.Open	File	Explorer.In	the	navigation	pane	on	the	left,
look	for	“Documents”	or	“My	Documents.”	It	is	often	listed	under	“This	PC”	or	“Quick	access.”Click	“Documents”	to	open	the	folder.You	can	transfer	photos	and	videos	from	your	phone	to	your	Windows	PC	using	File	Explorer.Android:	Connect	your	Android	phone	to	your	PC	using	a	USB	cable.	On	your	phone,	you	may	need	to	change	the	USB
connection	mode	to	“File	Transfer	(MTP)”	or	“Transfer	photos	(PTP).”iPhone:	Connect	your	iPhone	to	your	PC	using	a	USB	cable.	If	prompted	on	your	iPhone,	tap	“Trust”	or	“Allow”	to	let	your	PC	access	your	photos	and	videos.	You	may	need	iTunes	installed	on	your	PC.After	connecting	your	phone,	open	File	Explorer.Your	phone	should	appear	as	a
device	under	“This	PC”	or	“Devices	and	drives.”Double-click	your	phone’s	icon.Open	the	“Internal	storage”	or	“SD	card”	folder.Find	the	folder	containing	your	photos	and	videos.	This	is	often	“DCIM”	(Digital	Camera	Images).Select	the	photos	and	videos	you	want	to	import.Copy	them	(Ctrl+C).Go	to	the	folder	on	your	PC	where	you	want	to	save	them
(e.g.,	“Pictures”).Paste	them	(Ctrl+V).Alternatively,	Windows	Photos	app	can	also	import	photos.	Right-click	your	phone	in	File	Explorer	and	select	“Import	pictures	and	videos.”OneDrive	is	Microsoft’s	cloud	storage	service.	You	can	integrate	it	with	File	Explorer	for	easy	access	and	syncing.If	OneDrive	is	not	set	up,	search	for	“OneDrive”	in	the	Start
menu	and	open	the	app.Sign	in	with	your	Microsoft	account.	If	you	do	not	have	one,	you	can	create	one.Follow	the	on-screen	instructions	to	choose	your	OneDrive	folder	location	and	select	which	folders	to	sync.Once	set	up,	a	OneDrive	folder	will	appear	in	File	Explorer’s	navigation	pane.Files	you	add	to	this	folder	will	automatically	sync	to	the	cloud
and	your	other	devices.File	Explorer	allows	you	to	manage	your	files	effectively.	Here	are	some	common	tasks.Open	File	Explorer	and	find	the	document	or	file	you	want	to	print.Right-click	the	file.Select	“Print”	from	the	context	menu.This	option	is	available	for	file	types	that	support	direct	printing	(like	.txt,	.pdf	if	a	reader	is	set	as	default,	image
files).	Otherwise,	you	may	need	to	open	the	file	in	its	application	and	print	from	there.Windows	does	not	have	a	built-in	direct	resize	option	in	File	Explorer’s	right-click	menu	for	all	versions.Using	Paint	(or	Paint	3D):Right-click	the	image	file	in	File	Explorer.Select	“Open	with”	then	choose	“Paint”	or	“Paint	3D.”In	Paint,	use	the	“Resize”	option	(on	the
Home	tab).Adjust	the	size	by	percentage	or	pixels.Save	the	resized	image.Using	Microsoft	PowerToys	(Advanced):Install	Microsoft	PowerToys.Enable	the	“Image	Resizer”	utility.Right-click	an	image	file	(or	multiple	selected	images)	in	File	Explorer.Select	“Resize	pictures.”Choose	a	predefined	size	or	enter	a	custom	size.	Click	“Resize.”In	File
Explorer:Open	File	Explorer	and	find	the	photos	you	want	to	delete.Select	the	photo(s).Press	the	Delete	key	on	your	keyboard,	or	right-click	and	select	“Delete.”Deleted	files	usually	go	to	the	Recycle	Bin.In	Photos	App:Open	the	Photos	app.Find	and	select	the	photo(s)	you	want	to	delete.Click	the	“Delete”	icon	(often	a	trash	can)	or	right-click	and
select	“Delete.”File	Explorer	itself	does	not	save	files;	applications	do.	When	you	save	a	file	from	an	application	(like	Word	or	Notepad):In	the	application,	choose	“File”	>	“Save”	or	“File”	>	“Save	As.”A	“Save	As”	dialog	box	will	appear.	This	dialog	box	is	a	version	of	File	Explorer.Choose	the	folder	where	you	want	to	save	the	file.Enter	a	name	for	the
file	in	the	“File	name”	box.Click	“Save.”Open	File	Explorer.Go	to	the	“View”	tab	on	the	ribbon.In	the	“Layout”	section,	select	“Large	icons,”	“Extra	large	icons,”	or	“Medium	icons.”	These	options	show	thumbnails	for	image	and	video	files.Windows	scales	text	size	system-wide,	which	affects	File	Explorer.Right-click	on	your	desktop	and	select	“Display
settings.”Under	“Scale	and	layout,”	find	the	“Change	the	size	of	text,	apps,	and	other	items”	dropdown	menu.Select	a	larger	percentage	(e.g.,	125%,	150%).	This	will	make	text	larger	across	Windows,	including	File	Explorer.You	may	need	to	sign	out	and	sign	back	in	for	changes	to	apply	fully.For	more	granular	control	over	only	text	size	(not	all
elements),	search	“Make	text	size	bigger”	in	Windows	Settings.Open	File	Explorer.Click	the	“View”	tab	on	the	ribbon.On	the	far	right	of	the	View	ribbon,	click	“Options.”	(In	some	Windows	versions,	it	might	be	an	icon,	or	under	a	“…”	menu).This	opens	the	“Folder	Options”	window,	where	you	can	change	many	File	Explorer	settings.Open	File
Explorer.Click	the	“View”	tab	on	the	ribbon.In	the	“Panes”	group,	click	“Preview	pane.”A	new	pane	will	appear	on	the	right	side	of	File	Explorer.	When	you	select	a	file	(like	an	image,	PDF,	or	text	document),	you	will	see	its	content	in	this	pane.If	File	Explorer	causes	problems	in	Windows	11,	try	these	suggestions.If	File	Explorer	looks	different	or
behaves	strangely,	try:Restarting	File	Explorer:	See	“Restart	File	Explorer	in	Task	Manager”	below.Checking	View	Options:	Go	to	“View”	>	“Layout”	and	ensure	your	preferred	layout	is	selected.	Check	“View”	>	“Show/hide	options“.Resetting	Folder	Views:	In	File	Explorer	Options	(View	>	Options),	click	“View”	tab,	then	“Reset	Folders,”	then	“Yes.”
Then	click	“Restore	Defaults.”Checking	for	Windows	Updates:	Updates	can	fix	known	issues.When	File	Explorer	stops	responding	or	freezes:Restart	File	Explorer:	This	is	often	the	quickest	fix.	See	“Restart	File	Explorer	in	Task	Manager”	below.Check	for	problematic	extensions:	Third-party	software	can	add	shell	extensions	that	cause	issues.Run
System	File	Checker:	Corrupt	system	files	can	cause	problems.	See	“Run	System	File	Checker	(SFC)	and	DISM”	below.If	File	Explorer	crashes	repeatedly:Restart	File	Explorer.Update	Windows	and	drivers:	Outdated	software	or	drivers	can	cause	instability.Perform	a	clean	boot:	This	helps	identify	if	third-party	software	is	the	cause.	Search	for
“msconfig,”	go	to	Services,	hide	Microsoft	services,	and	disable	the	rest.	Then	check	Task	Manager’s	Startup	apps.Check	system	files:	Use	SFC	and	DISM	tools.If	basic	troubleshooting	does	not	work,	these	advanced	tips	might	help	fix	File	Explorer	issues.Press	Ctrl	+	Shift	+	Esc	to	open	Task	Manager.In	the	“Processes”	tab,	find	“Windows
Explorer.”Right-click	“Windows	Explorer”	and	select	“Restart.”Your	taskbar	and	desktop	icons	might	disappear	briefly	and	then	reappear.Open	Command	Prompt	as	an	administrator.	Search	“cmd,”	right-click	Command	Prompt,	and	select	“Run	as	administrator.”Type	taskkill	/f	/im	explorer.exe	and	press	Enter.	This	will	close	File	Explorer	and	your
desktop.Type	start	explorer.exe	and	press	Enter.	This	will	restart	File	Explorer.Incorrect	or	very	high	display	resolutions	or	scaling	settings	can	sometimes	affect	File	Explorer’s	performance.Right-click	your	desktop	and	select	“Display	settings.”Try	a	different	scaling	percentage	(e.g.,	100%	or	125%).Try	a	common	screen	resolution	for	your
monitor.If	you	use	multiple	monitors,	try	using	only	one	to	see	if	the	issue	persists.A	full	system	drive	(usually	C:)	can	cause	many	problems,	including	File	Explorer	issues.Open	File	Explorer,	click	“This	PC.”Check	the	free	space	on	your	Local	Disk	(C:).If	it	is	low,	free	up	space.	Use	Disk	Cleanup	(search	“Disk	Cleanup”	in	Start).	Uninstall	unused
programs.	Move	large	files	to	another	drive.You	can	use	Disk	Management	to	extend	C:	drive	if	there	is	unallocated	space	next	to	it.	Right-click	Start,	select	“Disk	Management.”A	corrupted	user	profile	can	cause	File	Explorer	problems.Go	to	“Settings”	>	“Accounts”	>	“Family	&	other	users“.Click	“Add	someone	else	to	this	PC”	(or	“Add
account“).Follow	prompts	to	create	a	new	local	user	account.Sign	out	of	your	current	account	and	sign	in	to	the	new	account.Check	if	File	Explorer	works	correctly	in	the	new	account.	If	it	does,	your	old	user	profile	might	be	the	issue.	You	can	then	transfer	your	files	to	the	new	account.Windows	includes	troubleshooters	that	can	automatically	find
and	fix	some	common	problems.Go	to	“Settings”	>	“System”	>	“Troubleshoot”	(or	Settings	>	Update	&	Security	>	Troubleshoot	in	older	Windows	versions).Click	“Other	troubleshooters”	or	“Additional	troubleshooters.”Look	for	troubleshooters	related	to	“Search	and	Indexing”	or	“System	Maintenance.”	Running	these	might	help	File	Explorer
issues.You	can	reset	File	Explorer	settings	to	their	defaults.Open	File	Explorer	Options	(View	tab	>	Options).On	the	“General”	tab,	click	“Restore	Defaults.”Go	to	the	“View”	tab,	click	“Restore	Defaults.”Click	“Apply,”	then	“OK.”For	a	more	thorough	reset,	you	might	need	to	edit	the	registry	(advanced	users	only,	back	up	registry	first).These	tools
check	for	and	repair	corrupted	Windows	system	files.Open	Command	Prompt	as	an	administrator.Type	sfc	/scannow	and	press	Enter.	Wait	for	the	scan	to	complete.If	SFC	finds	issues	but	cannot	fix	them,	or	if	problems	persist,	run	DISM.In	the	same	Command	Prompt,	type	DISM	/Online	/Cleanup-Image	/RestoreHealth	and	press	Enter.	Wait	for	this
process	to	complete.Restart	your	PC	after	the	scans.If	you	still	need	help:Use	the	“Get	Help”	app	in	Windows	(search	“Get	Help”	in	Start).Visit	the	official	Microsoft	Support	website.Search	for	solutions	or	ask	questions	in	Microsoft	Community	forums	or	other	reputable	tech	forums.Ensure	your	Windows	operating	system	is	up	to	date.Go	to
“Settings”	>	“Windows	Update”	(or	Settings	>	Update	&	Security	>	Windows	Update).Click	“Check	for	updates.”Install	any	available	updates.	Restart	your	PC	if	required.	Updates	often	include	fixes	for	known	issues.File	Explorer	itself	does	not	have	a	dedicated	help	search	function	that	connects	to	online	resources	directly	within	its	window	like
some	older	applications.To	find	specific	options	or	settings	within	File	Explorer,	use	its	interface:	the	ribbons	(Home,	Share,	View)	and	the	“Options”	menu.For	general	help	or	troubleshooting,	use	the	Windows	Search	bar	on	your	taskbar.	Type	your	question	or	keywords	like	“File	Explorer	help”	or	“fix	File	Explorer	crash.”You	can	also	use	the	“Get
Help”	app	included	with	Windows.	Search	for	“Get	Help”	in	the	Start	menu.If	you	need	different	features	or	find	File	Explorer	unsuitable	for	specific	tasks,	you	can	consider	alternative	file	manager	applications.	Some	popular	third-party	file	managers	include:These	alternatives	often	offer	features	like	dual-pane	views,	advanced	search	capabilities,
and	more	customization	options.That’	all	about	how	to	get	help	with	File	Explorer	in	Windows.Whether	it’s	sluggish	performance,	unexpected	crashes,	or	simply	not	knowing	how	to	find	what	you	need,	remember	that	solutions	are	within	reach.From	built-in	troubleshooters	and	system	file	checks	to	seeking	community	advice	or	leveraging	Microsoft’s
official	support	channels,	you’re	now	equipped	with	several	avenues	to	get	File	Explorer	back	on	track.By	proactively	addressing	issues	and	knowing	where	to	turn	for	help,	you	can	ensure	smoother	navigation,	better	organization,	and	a	more	productive	digital	life	on	your	Windows	PC.IT	Security	/	Cyber	Security	Experts.	Technology	Enthusiasm.
Love	to	read,	test	and	write	about	IT,	Cyber	Security	and	Technology.	The	Geek	coming	from	the	things	I	love	and	how	I	look.	How	to	make	the	best	use	of	File	Explorer?	In	this	post,	you	will	get	the	best	help	with	File	Explorer	in	Windows	10	in	all	aspects	such	as	the	Keyboard	Shortcut,	the	Quick	Access,	the	Hard	Drive	Management,	and	more.File
Explorer,	formerly	known	as	Windows	Explorer,	is	a	file	manager	first	appeared	since	Windows	95.	It	provides	a	graphical	user	interface	and	easy	access	to	the	management	of	files	saved	on	the	whole	computer,	such	as	the	desktop,	the	library,	the	system	partition,	and	even	change	their	properties.Almost	all	Windows	users	open	File	Explorer	to
manage	their	files.	With	this	in	mind,	we	feel	there	is	a	need	to	show	you	Windows	10	file	explorer	help.How	to	Access	Windows	10	File	ExplorerThe	first	Windows	10	File	Explorer	help	is	how	to	open	File	Explorer.	There	are	multiple	ways	to	access	Windows	File	Explorer,	to	summarize:From	This	PC.	When	your	computer	is	on,	you	will	find	an	icon
named	This	PC	on	the	desktop.	By	double-clicking	on	it,	you	will	get	the	interface	of	File	Explorer.From	the	Taskbar.	Normally,	when	your	PC	is	turned	on,	you	are	able	to	launch	some	programs	from	the	taskbar,	provided	that	they	are	already	locked	prior	to	this	operation.From	Cortana.	Each	Windows	10	edition	comes	with	intelligent	assistance
Cortana.	If	you	neither	have	This	PC	on	the	desktop	or	File	Explore	on	the	taskbar,	you	can	type	File	Explorer	in	the	Cortana	search	box	and	then	find	it	from	the	best	match.	Since	you	are	here,	you	can	pin	it	to	the	Windows	Start	menu	or	the	taskbar.From	Start	menu.	By	clicking	the	Windows	Start	menu,	you	can	easily	find	an	item	called	File
Explorer.From	Power	User	Task	Menu.	Press	the	Windows	logo	key	and	X	together	to	load	the	Power	User	menu,	then	File	Explorer	should	be	listed	there.From	Shortcut	key.	By	pressing	the	Windows	logo	key	and	E	together,	the	File	Explorer	will	appear	immediately.When	you	are	in	Windows	10	File	Explorer,	you	will	see	the	five	categories	from	the
left	action	panel,	and	they	are	Quick	access,	OneDrive,	This	PC,	Libraries,	and	Network.Check	out	how	to	open	File	Explorer	with	multiple	approaches!Click	to	TweetBest	Features	in	Windows	10	File	ExplorerDespite	File	Explore	in	Windows	10	provides	users	with	multiple	useful	features,	you	might	be	wondering	if	there	is	any	Windows	10	file
explorer	tutorial	that	helps	you	go	through	all	the	tricks	easily.	Here	are	the	top	features	that	are	popular	among	the	users.Home	Tab:	It	located	on	the	top	left	corner	of	the	file	explorer,	the	new	home	tab	makes	most	of	the	tasks	and	commands	easier	than	before	and	it	copying	a	file	or	be	it	deleting	it,	and	you	can	perform	it	via	the	home	tab.	In
Windows	10,	whenever	you	tap	Windows	+	E,	you’ll	be	taken	to	the	Home	tabShare	Tab:	You	can	find	the	share	tab	on	the	top	left	corner	in	the	file	explorer,	and	this	tab	allows	you	to	share	plenty	of	files	and	folders	wherever	you	want	via	just	one	tap.	For	sharing	a	file,	you	can	also	convert	the	files	into	the	zip	format	as	well	as	burn	them	with	the
help	of	the	share	tabView	Tab:	you	can	preview	the	pictures	and	documents	by	clicking	the	Preview	pane;	you	can	change	the	file	preview	from	small	icon	showing	details	to	large	icons	showing	titleQuick	Access:	It	is	one	of	the	most	helpful	features	of	the	latest	file	explorer,	and	with	this	feature,	you	can	visit	files	and	folders	which	you	have
frequently	visited.	There	are	mainly	two	different	sections	in	this	feature	of	frequent	folders	and	recent	filesOneDrive:	Windows	Explorer	in	Windows	8.1	allows	you	to	save	files	directly	to	OneDrive	but	you	cannot	sync	the	files	in	OneDrive	with	your	PC	or	local	system.	The	new	file	explorer	has	overcome	this	drawback.	You	can	now	not	only	save	the
files	to	OneDrive	but	at	the	same	time	sync	them	with	the	systemFile	Explorer	Windows	10	Keyboard	ShortcutsHere	is	the	guide	for	File	Explorer	Windows	10	Keyboard	Shortcuts.	If	you	are	much	addicted	to	your	keyboard,	then	it	is	good	for	you	to	keep	these	keyboard	shortcuts	in	mind.	Here	we	list	some	useful	Windows	File	Explorer	keyboard
shortcuts:Alt	+	DGo	to	the	address	barAlt	+	EnterDisplay	the	Properties	of	the	selected	file	or	folder.Alt	+	Left	Arrow	KeyGo	back	One	Folder	in	history.Alt	+	Right	Arrow	KeyGo	forward	One	Folder	in	history.Alt	+	PShow/Hide	the	Preview	pane.Ctrl	+	DMove	file	or	folder	to	Recycle	Bin.Ctrl	+	EGo	to	the	search	box.Ctrl	+	EActivate	the	Search	bar	in
File	Explorer.Ctrl	+	FGo	to	the	search	box.Ctrl	+	Mouse	Wheel	up	or	DownIncrease	or	Decrease	the	size	of	Icons	in	File	Explorer.Ctrl	+	NOpen	a	new	File	Explorer	window.Ctrl	+	Shift	+	EDisplay	all	folders	above	the	selected	folder.Ctrl	+	Shift	+	N:Create	a	new	folder.Ctrl	+	WClose	the	current	File	Explorer	window.F11Maximize	or	minimize	the
active	window.HomeDisplay	the	top	item	in	the	active	window.Num	Lock	+	Asterisk	(*)Display	all	subfolders	under	the	selected	folder.Num	Lock	+	Minus	(-)Collapse	the	selected	folder.Num	Lock	+	Plus	(+)Display	the	contents	of	the	selected	folder.Shift	+	DeletePermanently	delete	file	or	folder.We	hope	these	keyboard	shortcuts	let	all	of	you	get
help	with	file	explorer	in	Windows	10.Enable/Disable	Quick	Access	to	the	Main	ScreenAs	everything	has	two	sides,	while	many	users	speak	highly	of	Quick	Access,	some	users	feel	it	is	troublesome	to	switch	to	This	PC	each	time	when	they	open	File	Explore.	In	fact,	it	is	rather	to	customize	what	you	see	at	the	first	sight	when	you	open	Windows	File
Explorer.Step	1.	Click	File	and	then	Change	folder	and	search	options.Step	2.	In	the	next	pop-up	window,	drop	down	the	box	of	Open	File	Explorer	to.	Right	there	you	will	find	two	options	and	they	are	Quick	Access	and	This	PC.	Just	select	the	one	you	prefer	and	then	you	will	see	what	you	want	next	time	when	you	open	File	Explorer.Note:	Should	you
choose	Quick	Access,	please	make	sure	the	two	options	under	Privacy	is	enabled.Pin	the	Frequently	Used	to	Quick	AccessQuick	Access	is	located	in	the	first	place	of	the	left	panel	which	shows	you	the	most	frequently	used	folders	and	the	recent	files	created/modified.	For	those	who	have	a	vast	number	of	files/folders	saved	on	the	computer,	it	is	wise
to	find	the	target	files	from	Quick	Access.However,	if	the	files	you	want	do	not	appear,	you	can	pin	to	Quick	Access.	Here	is	how	you	can	do	this:Right-click	the	target	file/folder.	From	the	context	menu,	select	Pin	to	Quick	access	as	the	following	picture	shows.	(Tip:	to	remove,	just	select	Unpin	from	Quick	Access.)Tip:	If	someday	you	need	to	remove	a
file	from	Quick	Access,	just	select	that	files	and	choose	Remove	from	Quick	access	from	the	context	menu.Manage	Hard	Drive	in	This	PCBy	entering	This	PC,	you	are	able	to	view	all	FAT	and	NTFS	partitions	that	have	drive	letters.	And	it	is	also	possible	to	perform	something	basic	to	manage	hard	drive	partitions.	Specifically	speaking,	you	can	copy,
format,	rename	the	displayed	partitions	and	view	its	properties.Usually,	when	it	comes	to	disk	partition	management,	most	Windows	users	go	for	Disk	Management	or	they	turn	to	third-party	software	for	help.	And	in	most	cases,	the	latter	one	such	as	MiniTool	Partition	Wizard	is	deeply	trusted.Simply	put,	MiniTool	Partition	Wizard	makes	it	easier	to
repartition	hard	drive,	to	convert	file	system,	to	convert	partition	style,	to	change	cluster	size,	to	manage	dynamic	disks,	and	more,	which	is	much	powerful	than	the	Windows	tools.	Till	now,	more	than	tens	of	millions	of	users	get	their	issue	resolved	by	using	this	all-in-one	partition	manager.Go	to	the	product	page	to	get	the	details	if	you	are
interested	or	you	may	just	download	the	free	edition	to	have	a	try	first.MiniTool	Partition	Wizard	FreeClick	to	Download100%Clean	&	SafeFile	Explorer	Windows	10	Not	Working	after	Right	ClickDespite	that	File	Explorer	is	frequently	used	every	day,	sometimes	you	will	find	File	Explorer	Windows	10	not	working.	One	of	the	most	typical	issues	is	that
File	Explorer	crashes/hangs	after	right	click.If	you	are	bothered	by	the	same	issue,	you	may	just	follow	the	simple	guideline	below	to	get	help	with	file	explorer	in	Windows	10.Fix	1	–	Using	CMD	to	Fix	File	Explorer	CrashStep	1.	Press	Windows	key	and	X	at	the	same	time	to	launch	the	power	user	menu,	then	choose	Command	Prompt	(Admin)	option
from	the	list	of	choice.	If	it	does	not	appear,	do	this	in	the	Cortana	search	box.Step	2.	In	the	command	line	window,	type	netsh	and	hit	Enter.	Then	continually	type	winstock	reset	and	hit	Enter.Step	3.	Now	restart	your	computer	and	check	if	the	issue	is	resolved.Fix	2	–	Uninstall	UpdateStep	1.	Follow	the	path:	Start	button	->	Settings	->	Update	&
security.	Then	one	the	left	pane,	choose	Windows	Update,	and	on	the	right	pane,	choose	View	update	history.Step	2.	Click	Uninstall	updates.	Then	in	the	new	window,	check	if	there	is	an	update	item	named	KB3081449	or	KB3081448.	If	you	can	find	one,	right-click	on	it	and	choose	Uninstall.Step	3.	Restart	your	computer	and	then	check	out	if	the	File
Explorer	Windows	10	not	working	issue	has	been	removed.Here	are	the	solutions	to	Windows	10	File	Explorer	not	working	after	right	click.	Those	who	are	getting	stuck	with	this	issue	may	just	have	a	try.Click	to	TweetFinal	WordsReading	here,	guess	you	have	a	better	understanding	of	Windows	10	file	explorer	tutorial.	Hope	that	your	problem	with
Windows	10	File	Explorer	is	solved.	In	the	coming	days,	you	should	find	it	easier	to	work	with	Windows	10.If	you	have	any	suggestions	on	getting	help	with	File	Explorer	Windows	10,	you	can	leave	us	comments	or	send	an	email	to	[email	protected]	in	the	following	area	to	help	more	users.	Thanks	in	advance.	What	is	File	Explorer?	File	Explorer	also
called	Windows	Explorer	in	the	earlier	Windows	version,	is	a	crucial	tool	in	Windows	10.	Usually,	we	use	it	to	view	files	and	folders	every	day,	but	actually,	Windows	inserted	various	features	that	help	you	to	well	manage	your	data.	Refer	to	this	article,	it	helps	you	to	access	it	and	illustrates	how	to	get	help	with	File	Explorer	in	Windows	10.	How	to
launch	File	Explorer	in	Windows	10	or	11?	There	are	many	methods	to	open	the	File	Explorer	in	Windows.	Here	we	list	the	most	common	way.	Method	1.	Keyboard	shortcut	By	pressing	the	“Win	+	E”	key,	the	File	Explorer	will	be	opened	up.	Method	2.	The	PC	icon	On	the	Desktop,	double-click	the	“This	PC”	icon	or	right-click	it	and	hit	“Open”,	and
you	will	see	this	tool.	Method	3.	The	Start	menu	Click	the	“Start”	on	the	left	bottom,	and	click	“This	PC”	or	go	“Windows	System”	>	“This	PC”	to	open	it.	✍Tip:	If	you	find	File	Explorer	icon	missing	from	Start	menu,	follow	these	instructions:	1.	Click	“Start”	>	“Setting”	>	“Personalization”.	2.	Click	“Start”	on	the	left-side	panel,	and	click	“Choose	which
folders	appear	on	Start”	3.	Turn	on	the	File	Explorer	button.	Then	you	will	see	the	File	Explorer	icon	in	the	Start	menu.	Method	4.	The	Cortana	search	Microsoft	built	in	Cortana	virtual	assistant,	click	the	Cortana	search	box,	type	“file	explorer”	on	it,	and	press	Enter.	Then	File	Explorer	will	be	opened.	Method	5.	Power	User	Task	Press	“Win	+	X”	to
open	Power	User	Task,	and	click	“File	Explorer”.	How	to	get	Help	with	File	Explorer	in	Windows	10	or	Windows	11	Now	I	believe	you	have	known	how	to	open	File	Explorer.	In	the	next	part,	we	will	walk	you	through	the	main	features	of	File	Explorer	in	Windows	10	or	Windows	11.	How	to	use	the	Ribbon	Ribbon	is	like	a	guiding	box	demonstrating
some	simple	operation	you	can	execute	in	a	click	or	serveral	steps.	When	you	open	File	Explorer,	you	can	see	the	Ribbob	on	the	top	of	it.	If	it	is	there,	Press	keys	"Ctrl	+	F1"	simultaneously.	There	are	3	tabs	in	Ribbon:	Home,	Share,	View.		Here	are	some	information	about	these	tabs.	1.	The	“Home”	tab	provides	some	basic	functions	and	information
for	you	like	pinning	to	quick	access,	creating	a	new	folder,	copy,	delete,	select,	properties,	etc.	For	example,	you	may	want	to	copy	or	move	a	file	or	folder	to	another	place,	like	you	may	want	to	get	your	files	on	a	USB	drive,	or	move	your	photos	on	your	computer.	You	can	click	the	file	or	folder	to	choose	it,	and	click	the	"Move	to"	or	"Copy	to",	and
choose	destination	folder	to	move	or	duplicate	a	file	or	folder.	✍Note:		1.	you	should	know	that	"Move	to"	will	delete	the	iriginal	document,	while	"Copy	to"	will	make	a	copy	of	the	seleted	file	on	another	place.	2.	If	you	want	to	copy	a	file,	you	can	open	the	destination	folder	and	the	original	folder	simultaneously,	and	click	and	drag	the	file	or	folder	to
the	folder	where	you	want	to	put	the	file.	2.	“Share”	tab	gives	the	options	to	share	files	with	your	friends.	By	clicking	E-mailing,	faxing,	printing,	cloning	icon,	you	can	choose	different	way	to	share	your	data	with	others.	Just	choose	one	of	these	way,	and	follow	its	prompts.	3.	With	the	“View”	tab,	you	can	adjust	the	appearance	of	the	File	Explorer.
This	tab	allows	you	to	decide	the	size	of	icons	and	to	sort	files	or	folder	in	different	way.	And	you	can	also	hide	selected	items	if	you	don't	want	it	to	be	viewed	by	others.	Besides,	With	“view”	tab,	you	can	preview	pictures,	Word	files	and	determine	the	arrangement	of	files.	How	to	use	Quick	Access	Quick	Access	is	also	a	great	function	you	can	get	help
with	File	Explorer	in	Windows	10.	With	this	function,	you	can	access	any	folders	with	just	one	click.	Here	is	how	to	use	it.	Step	1.	Open	the	File	Explorer,	and	navigate	to	the	folder	you	want	to	pin	to	Quick	Access.	Step	2.	Right-click	the	folder	or	select	the	“Home”	tab,	and	click	“Pin	to	Quick	access”.	Then	it	would	be	added	to	Quick	Access.	Next
time,	you	want	to	access	this	folder,	you	can	just	click	the	folder	under	the	Quick	access.	Then	the	folder	will	be	opened	immediately.	✍Tip:	If	you	want	to	remove	it	from	Quick	access	one	day,	you	can	right-click	the	folder	under	the	Quick	access	and	select	“Unpin	from	Quick	access”.	How	to	backup	files	In	Windows	10	system,	you	can	back	up	or
store	your	files	with	File	History.	It	will	automatically	backup	your	files,	and	you	can	restore	the	file	to	any	previous	version	as	you	wish.	Firstly,	you	need	to	go	“Setting”	>	“Update&	Security”	>	“Backup”	and	enable	“Automatically	back	up	my	files”.	Then,	if	you	need	an	old	version	of	any	files,	you	can	click	the	“History”	icon	to	restore	previous
version	of	the	file	as	long	as	it	is	backup	by	File	History.	How	to	use	the	OneDrive	OneDrive	is	an	online	hosting	service	provided	by	Microsoft.	Like	other	cloud	drives,	Google	Drive,	Dropbox.	Once	you	upload	files	and	folders	to	OneDrive,	you	can	access	those	files	and	folders	from	any	other	devices	that	installed	OneDrive.	If	you	have	some	data	you
don’t	want	to	lose,	it	can	also	be	a	backup	tool.	Then	let’s	see	how	to	use	the	OneDrive.	Step	1.	Open	the	File	Explorer	and	drag	the	files	to	the	OneDrive	in	the	left	sidebar.	Step	2.	Then	you	will	be	prompted	to	get	a	Microsoft	account.	After	that,	the	files	will	be	uploaded	to	OneDrive.	When	it	is	finished,	you	can	access	any	files	in	the	OneDrive	with
your	Microsoft	account	via	OneDrive	App	or	OneDrive	website.	✍Note:	You	can	right-click	the	cloud-like	OneDrive	icon	at	the	bottom	right	corner	of	your	screen	to	change	specific	settings,	such	as	notifications	and	account	settings.	Shortcuts	in	File	Explorer	In	addition,	in	order	to	work	efficiently,	here	we	list	some	shortcuts	to	help	you	better	utilize
the	File	Explorer	in	Windows	10:	Shift	+	Delete	–delete	a	file	or	folder	Ctrl	+	D	–	delete	file	or	folder	to	recycle	bin	Ctrl	+	E	–	go	to	the	search	box	Ctrl	+	N	–	Open	a	new	File	Explorer	window	Ctrl	+	W	–	Close	the	current	File	Explorer	window	Alt	+	P	–	Show/Hide	the	preview	pane	Alt	+	Enter	–	Display	the	Properties	dialog	box	for	the	selected	file	or
folder	Alt	+	Right	arrow	–	View	the	folders	Alt	+	D	–	go	to	the	address	bar	Ctrl	+	middle	mouse	bottom–	change	the	size	of	each	file	in	the	current	window.	Ctrl	+	Shift	+	E	–	Display	all	folders	above	the	selected	folder	Ctrl	+	Shift	+	N	–	Create	a	new	folder	How	to	fix	File	Explorer	not	working?	File	Explorer	is	very	helpful	for	the	daily	use,	but	you
may	encounter	the	typical	issue	that	the	file	explorer	is	not	working	or	not	responding.	And	you	can	follow	the	steps	to	fix	this	issue.	Method	1:	Update	your	system	Step	1.	Go	“Start”	>	“Setting”	>	“Update	&	Security”	>	“Windows	Update”,	and	click	“Check	for	updates”.	Step	2.	Then	you	will	know	if	your	system	is	the	latest	version,	if	it	is	not,	please
update	it	to	the	latest.	Method	2.	Check	Corrupted	files	The	“File	Explorer	not	responding”	issue	is	probably	caused	by	file	corruption.	You	can	check	if	there	are	some	corrupted	files	with	Command	Prompt.	Step	1.	Press	“Win	+	R”,	and	type	“cmd”	on	the	Run	box	to	open	Command	Prompt.	Step	2.	Type	“sfc/scannow”	and	press	Enter.	Step	3.	After
the	scan,	this	command	will	fix	corrupted	files	automatically.	It	takes	just	a	few	minutes.	Method	3.	Extend	the	C	drive	You	may	not	store	plenty	of	files	on	C	drive	if	you	want	your	computer	to	run	smoothly.	However,	over	time,	the	C	drive	is	getting	full,	which	would	affect	the	running	of	the	computer,	so	the	File	Explorer	would	become	not	working
or	responding.	Then	you	can	extend	the	C	drive	with	third	party	software	to	solve	it.	AOMEI	Partition	Assistant	Professional	is	a	good	measure	for	you	to	extend	your	system	drive	to	improve	the	performance	of	your	computer.	With	just	a	few	steps,	you	can	allocate	free	space	from	another	drive	to	C	drive.	Besides,	it	is	also	a	hard	drive	manager.	If
you	want	to	format,	wipe,	create	partition,	split	partition,	which	are	not	supported	by	File	Explorer,	this	tool	can	also	help	you.	Download	the	Demo	version	and	see	how	it	works.	Step	1.	Open	the	AOMEI	Partition	Assistant,	and	right-click	the	partition	that	has	enough	space,	and	choose	“Allocate	Free	Space”.	Step	2.	Here	you	can	set	the	allocated
size	as	you	wish	to	C	drive,	and	click	“OK”.	Step	3.	Click	the	“Apply”	in	the	main	interface	to	start	allocating	free	space	to	C	drive.	Besides,	AOMEI	Partition	Assistant	has	other	functions	that	can	improve	computer	performance	so	that	the	issue	probably	can	be	fixed,	such	as,	migrating	Windows	10	to	SSD	and	aligning	partition.	✍Note:	If	your	system
is	Windows	Server,	you	should	download	AOMEI	Partition	Assistant	Server	Edition.	Conclusion	Now,	I	believe	you	have	a	rough	understanding	of	File	Explorer.	You	can	add	this	webpage	to	your	bookmark	so	as	to	you	can	read	it	at	any	time.	If	you	have	any	question	about	File	Explorer,	you	can	leave	a	comment,	or	if	you	have	other	tricks	to	utilize
File	Explorer,	you	can	also	share	to	other	users.	File	Explorer	is	one	of	the	most	important	parts	of	the	Windows	operating	system.	It	helps	users	view,	manage,	and	organize	their	files	and	folders.	If	you	want	to	open	documents,	move	photos,	search	for	files,	or	plug	in	a	USB	drive,	File	Explorer	is	the	tool	you	use.	While	it	usually	works	well,
sometimes	users	may	face	problems	or	need	help	using	certain	features.	This	article	will	guide	you	step-by-step	on	how	to	get	help	with	File	Explorer	in	Windows	10	and	Windows	11.	We	will	cover	how	to	open	File	Explorer,	use	it	effectively,	fix	common	issues,	and	where	to	find	support	if	something	goes	wrong.	This	article	is	made	for	everyone,
including	beginners.	The	goal	is	to	help	you	understand	and	solve	problems	on	your	own.	What	is	File	Explorer	File	Explorer	is	a	built-in	application	in	Windows	that	shows	you	all	the	files	and	folders	stored	on	your	computer.	It	was	called	Windows	Explorer	in	older	versions.	File	Explorer	lets	you	move,	copy,	rename,	delete,	and	organize	files.	It	also
helps	you	access	storage	devices	like	hard	drives	and	USB	sticks.	You	can	find	documents,	pictures,	music,	downloads,	and	more	inside	File	Explorer.	You	can	open	many	windows	at	once	and	work	with	different	folders	side	by	side.	It	also	lets	you	sort,	search,	and	view	files	in	different	ways.	How	to	Open	File	Explorer	in	Windows	10	and	11	There
are	several	easy	ways	to	open	File	Explorer:	Click	the	yellow	folder	icon	on	the	taskbar	Press	the	Windows	key	+	E	on	your	keyboard	Right-click	the	Start	menu	and	select	File	Explorer	Open	Start	and	type	“File	Explorer”	in	the	search	bar,	then	click	the	result	Any	of	these	methods	will	open	a	new	File	Explorer	window.	It	usually	starts	in	Quick
Access,	where	you	see	recent	files	and	frequently	used	folders.	Main	Sections	of	File	Explorer	When	you	open	File	Explorer,	you	will	see	a	window	with	several	parts:	Navigation	pane:	On	the	left,	you	will	see	folders	like	Desktop,	Documents,	Pictures,	Downloads,	and	This	PC.	You	can	click	them	to	open	quickly.	Address	bar:	This	shows	your	current
folder	location.	You	can	type	a	location	or	use	the	drop-down	menu	to	move	around.	File	list:	The	main	area	shows	the	contents	of	the	folder	you	are	in.	You	can	double-click	a	folder	to	open	it.	Ribbon	menu:	At	the	top,	there	are	options	like	New	Folder,	Copy,	Paste,	and	Properties.	These	change	based	on	what	you	have	selected.	Search	bar:	At	the
top-right	corner,	you	can	search	for	files	and	folders	by	name	or	keyword.	Using	File	Explorer	to	Organize	Files	File	Explorer	lets	you	do	many	things	with	files:	To	create	a	folder,	right-click	in	any	empty	space,	choose	“New”	then	“Folder”,	and	give	it	a	name.	To	rename	a	file,	right-click	it	and	choose	“Rename”,	or	click	it	once	and	press	F2.	To	copy
or	move	a	file,	select	it	and	use	right-click	>	Copy	or	Cut.	Then	go	to	the	new	location	and	right-click	>	Paste.	To	delete	a	file,	right-click	and	choose	“Delete”,	or	select	and	press	the	Delete	key.	Deleted	files	usually	go	to	the	Recycle	Bin	unless	removed	permanently.	To	view	details,	right-click	the	file	and	choose	“Properties”.	This	shows	size,	date
created,	and	other	information.	These	steps	work	the	same	way	in	both	Windows	10	and	Windows	11.	Changing	View	and	Sorting	Options	File	Explorer	gives	you	several	ways	to	view	files:	Click	the	“View”	tab	on	the	top	menu	Choose	options	like	List,	Details,	Large	Icons,	or	Tiles	Use	the	“Sort	by”	option	to	arrange	files	by	name,	size,	date,	or	type
Group	files	by	similar	details	using	“Group	by”	Changing	the	view	helps	you	find	and	manage	files	more	easily.	You	can	also	enable	or	disable	file	extensions	and	hidden	files	from	the	View	tab.	Using	Quick	Access	and	This	PC	Quick	Access	is	a	feature	that	shows	your	most	used	folders	and	recently	opened	files.	You	can	pin	folders	you	use	often	so
they	are	always	easy	to	find.	To	pin	a	folder:	Right-click	any	folder	Select	“Pin	to	Quick	access”	To	remove	it:	Right-click	the	pinned	folder	Choose	“Unpin	from	Quick	access	or	click	the	Pin	to	Quick	Access	again”	This	PC	shows	all	your	drives	and	main	folders	like	Documents,	Music,	and	Videos.	It	also	shows	how	much	storage	you	have	left	on	each
drive.	Searching	for	Files	in	File	Explorer	The	search	bar	at	the	top-right	of	File	Explorer	lets	you	find	files	by	name	or	content.	Just	type	a	word	or	part	of	the	name	and	press	Enter.	The	system	will	search	in	the	current	folder	and	its	subfolders.	Tips	for	faster	searching:	Type	file	extensions	like	*.docx	or	*.jpg	to	find	file	types	Use	filters	like	date
modified,	size,	or	keywords	in	file	content	Be	patient	when	searching	large	folders	You	can	also	go	to	the	Search	tab	after	typing	to	see	more	search	tools.	Fixing	Common	File	Explorer	Problems	Sometimes	File	Explorer	may	not	work	as	expected.	Here	are	common	issues	and	how	to	fix	them:	Try	these	solutions:	Restart	your	computer	Press	Ctrl	+
Shift	+	Esc	to	open	Task	Manager,	find	“Windows	Explorer”	and	click	“Restart”	Run	Windows	Update	to	get	the	latest	fixes	Scan	your	system	with	antivirus	software	in	case	of	malware	Fix	it	by:	Clearing	Quick	Access	history:	Open	File	Explorer	Options	>	Clear	Disabling	preview	pane:	Go	to	View	tab	and	uncheck	“Preview	pane”	Updating	your
system	and	drivers	Try:	Opening	in	Safe	Mode	to	check	if	another	app	is	causing	issues	Running	System	File	Checker:	Open	Command	Prompt	and	type	sfc	/scannow	Creating	a	new	user	account	to	see	if	the	problem	is	user-specific	If	you	cannot	find	a	file:	Check	the	Recycle	Bin	Use	the	search	bar	Make	sure	“Hidden	files”	are	visible	in	View	settings
Use	File	History	or	Backup	if	set	up	These	solutions	usually	solve	most	problems	users	face	with	File	Explorer.	How	to	Reset	File	Explorer	Settings	If	File	Explorer	settings	are	changed	and	you	want	to	go	back	to	default:	Open	File	Explorer	Click	“View”	tab	and	choose	“Options”	In	Folder	Options,	go	to	“General”	tab	and	click	“Restore	Defaults”	Do
the	same	in	the	“View”	tab	Click	Apply	and	OK.	This	will	reset	view	settings	and	Quick	Access	behavior.	Using	File	Explorer	Tabs	in	Windows	11	Windows	11	introduced	a	useful	feature	that	was	not	available	in	earlier	versions:	tabs	in	File	Explorer.	This	feature	allows	you	to	open	multiple	folders	in	one	window,	just	like	using	tabs	in	a	web	browser.
This	makes	multitasking	easier	and	helps	keep	your	screen	tidy.	To	open	a	new	tab:	Press	Ctrl	+	T	Or	click	the	“+”	button	at	the	top	of	the	File	Explorer	window	To	close	a	tab:	Press	Ctrl	+	W	Or	click	the	“X”	on	the	tab	You	can	drag	tabs	to	reorder	them	or	right-click	a	tab	for	more	options.	This	feature	is	currently	only	available	in	Windows	11,	and	it
works	very	smoothly.	Keyboard	Shortcuts	for	File	Explorer	Here	are	some	helpful	keyboard	shortcuts	that	can	make	using	File	Explorer	faster:	Windows	+	E	–	Open	File	Explorer	Ctrl	+	N	–	Open	a	new	File	Explorer	window	Ctrl	+	T	–	Open	a	new	tab	(Windows	11	only)	Alt	+	Left	Arrow	–	Go	back	Alt	+	Right	Arrow	–	Go	forward	Alt	+	Up	Arrow	–	Go
one	level	up	Ctrl	+	C	/	Ctrl	+	X	/	Ctrl	+	V	–	Copy	/	Cut	/	Paste	F2	–	Rename	selected	item	Delete	–	Move	selected	item	to	Recycle	Bin	Shift	+	Delete	–	Permanently	delete	item	Ctrl	+	Z	–	Undo	last	action	These	shortcuts	work	in	both	Windows	10	and	11,	except	for	tab	features	which	are	only	in	Windows	11.	Check	out:	How	to	Enable	or	Turn	Off
BitLocker	on	Windows	11	Customising	File	Explorer	Settings	You	can	make	File	Explorer	behave	the	way	you	like	by	changing	its	settings.	To	open	settings:	In	File	Explorer,	click	on	the	“View”	tab	Choose	“Options”	or	“Folder	Options”	In	the	General	tab:	You	can	change	whether	File	Explorer	opens	to	Quick	Access	or	This	PC	You	can	show	or	hide
recently	used	files	and	folders	You	can	enable	or	disable	single-click	to	open	items	In	the	View	tab:	You	can	choose	to	show	hidden	files	and	folders	You	can	show	file	extensions	for	known	types	You	can	reset	the	view	to	default	if	needed	These	settings	help	you	control	how	you	interact	with	files	and	folders.	File	Explorer	Integration	with	OneDrive	In
both	Windows	10	and	Windows	11,	OneDrive	is	built	into	File	Explorer.	This	means	your	cloud	files	appear	alongside	local	files.	You	can	find	OneDrive	in	the	navigation	pane	on	the	left	side.	If	you	are	signed	in	with	your	Microsoft	account,	files	in	your	OneDrive	will	be	synced	and	backed	up	to	the	cloud.	Features	include:	Automatic	syncing	of	files
Offline	access	to	recent	files	Easy	sharing	of	files	by	link	Freeing	up	space	with	the	“Free	up	space”	option	This	is	useful	if	you	want	to	back	up	important	folders	like	Documents	or	Pictures	without	using	a	USB	drive	or	external	hard	disk.	Troubleshooting	OneDrive	Issues	in	File	Explorer	Sometimes	users	face	problems	with	OneDrive	not	syncing	or
not	showing	up.	Here’s	what	you	can	do:	Make	sure	you	are	signed	into	your	Microsoft	account	Right-click	the	OneDrive	icon	in	the	taskbar	and	choose	“Settings”	Go	to	the	Account	tab	and	check	if	your	folders	are	selected	for	syncing	Restart	the	OneDrive	app	Run	the	built-in	troubleshooter:	Go	to	Settings	>	System	>	Troubleshoot	>	Other
troubleshooters	>	OneDrive	If	the	problem	continues,	visit	the	official	Microsoft	support	site	for	help.	File	Explorer	and	External	Devices	When	you	plug	in	a	USB	drive,	external	hard	disk,	or	SD	card,	File	Explorer	should	show	it	under	“This	PC”	or	“Devices	and	Drives.”	You	can	open	it,	move	files,	and	safely	remove	it	afterward.	If	the	device	does	not
show	up:	Try	using	a	different	USB	port	Check	if	the	device	works	on	another	computer	Open	Disk	Management	(Windows	+	X	>	Disk	Management)	to	see	if	it	appears	there	Assign	a	drive	letter	if	needed	Update	USB	drivers	in	Device	Manager	These	steps	help	fix	issues	with	external	devices	not	appearing	in	File	Explorer.	How	to	Reinstall	or	Repair
File	Explorer	If	File	Explorer	is	badly	broken	and	nothing	else	works,	you	can	try	repairing	or	resetting	it.	Windows	does	not	allow	uninstalling	File	Explorer,	but	you	can	reset	system	components.	Options	include:	Running	the	System	File	Checker	(sfc	/scannow)	Running	the	DISM	Tool	(DISM	/Online	/Cleanup-Image	/RestoreHealth)	Creating	a	new
user	account	Performing	a	Repair	Install	of	Windows	using	the	Media	Creation	Tool	These	advanced	steps	are	safe	if	followed	carefully	and	can	fix	deep	issues	in	the	system.	When	to	Seek	Professional	Help	If	File	Explorer	problems	do	not	go	away	even	after	troubleshooting,	it	may	be	time	to	contact	professional	support.	You	can:	It	is	important	not
to	modify	system	files	or	download	third-party	“fix”	tools	from	unknown	sources.	They	may	cause	more	harm	than	good.	Conclusion	File	Explorer	is	more	than	just	a	tool	to	browse	files.	It	plays	a	big	role	in	daily	computer	use.	Whether	you	are	a	student,	employee,	or	home	user,	knowing	how	to	use	and	fix	File	Explorer	will	make	your	work	smoother
and	save	time.	This	guide	showed	you	how	to	open	File	Explorer,	organize	files,	change	settings,	solve	problems,	and	use	advanced	features	like	tabs	and	cloud	syncing.	With	these	steps,	you	can	take	full	control	of	how	you	use	your	computer.	Always	keep	your	system	updated,	stay	aware	of	new	features,	and	never	hesitate	to	ask	for	help	when	you
need	it.	With	this	knowledge,	you	are	now	ready	to	explore,	manage,	and	troubleshoot	files	in	Windows	10	and	11	with	ease.	Read	more:	Why	You	Should	Go	Passwordless	Using	Windows	Hello	on	Windows	By	Victor	Ashiedu	Published	June	17,	2019	As	a	Windows	user	(and	admin),	you	will	work	with	File	Explorer.	This	article	is	a	comprehensive
guide	covering	every	aspect	of	this	important	Windows	tool.	To	make	it	easy	to	find	the	specific	File	Explorer	help	you	need,	expand	“Browse	Post	Topics”	below.	Then,	click	on	the	Windows	10	File	Explorer	help	topic	you	require.	The	most	logical	topic	to	start	our	how	to	get	help	with	File	Explorer	in	Windows	10	is	to	show	you	different	methods	to
open	File	Explorer.	Below	are	2	different	common	methods	to	open	File	Explorer:	Enter	File	Explorer	in	the	search	box	at	the	bottom	left	of	the	Windows	10	Taskbar.	Then,	from	the	search	results,	open	the	File	Explorer	App.	By	default,	File	Explorer	will	open	in	Quick	Access.	On	the	explorer	pane,	it	will	display	your	“Frequent	Folders”	and	“Recent
Files”.	Right-click	the	Start	Menu	at	the	bottom	left	of	your	Windows	10	Taskbar.	Then,	from	the	displayed	options,	click	A	number	of	Windows	10	users	want	to	get	help	with	File	Explorer	Ribbons.	This	section	explains	the	3	Ribbons	in	Windows	10	File	Explorer	and	how	to	use	them.	Each	sub-section	in	this	section	focuses	on	the	File	Explorer
Ribbons	–	Home,	Share	and	View.	The	“Home”	Ribbon	of	File	Explorer	has	5	sections	–	Clipboard,	Organise,	New,	Open,	and	Select.	The	table	below	explains	what	you	can	do	in	each	section:	S/NHome	Ribbon	SectionActions	You	Can	Perform1ClipboardYou	can	pin	selected	items	to	Quick	access.	You	can	also	Copy,	Paste,	Cut,	Copy	shortcut	and	Copy
path	of	selected	items.2OrganiseThis	section	gives	options	to	Move	to,	Copy	to,	Delete	or	Rename	a	selected	item.3NewHere,	you	can	create	a	new	folder,	shortcut,	or	a	new	file.	You	can	also	map	the	current	folder	as	a	network	drive	or	make	the	folder	available	offline	if	shared.4OpenThe	Open	section	gives	options	to	view	the	properties	of	the
selected	item.	You	can	also	open	a	folder	from	this	section.	Finally,	you	can	open	a	selected	file	for	editing.5SelectIn	this	section,	you	can	do	the	following:	Select	all,	Select	none,	and	Inverse	select.	Inverse	select	deselects	a	selected	item	and	selects	all	other	items	in	the	folder.	The	ribbon	“Share”	Ribbon	has	two	sections:	Send	and	Share	with.	Here
are	the	things	you	can	do	in	each	section:	S/NShare	Ribbon	SectionActions	You	Can	Perform1Send	In	this	section,	you	can	share	a	file	with	an	app	or	Zip	a	set	of	files	or	folders.	You	can	also	Email,	Burn	to	disk,	Print,	or	Fax	a	file.2Share	withIn	the	“Share	with”	section,	you	can	also	share	folders	with	specific	people	on	the	computer,	Remove	access
to	a	shared	folder	or	open	the	Advanced	security	settings	of	a	folder.	The	image	below	shows	the	advanced	security	settings	of	a	folder	opened	by	clicking	Advanced	security	directly	from	File	Explorer	Share	tab,	Share	with	section.	Like	the	2	Ribbons	already	covered,	the	“View”	Ribbon	has	section.	The	5	sections	in	the	Windows	10	File	Explorer
“View”	Ribbon	are	explained	in	the	table	below.	S/NView	Ribbon	SectionActions	You	Can	Perform1PanesThis	section	allows	you	to	modify	the	navigation	pane.	To	access	the	options,	click	the	Navigate	pane	drop-down.	To	remove	the	navigation	pane	(just	below	the	highlighted	box,	uncheck	Navigate	pane.	You	can	also	Click	Show	all	folders	to	show
all	folders	in	the	Navigation	pane.2LayoutThe	“Layout”	Section	gives	you	the	option	to	configure	how	your	File	Explorer	looks.	You	can	make	your	icons	Extra	Large,	Medium	sized	or	even	use	the	List,	or	Details	view.	You	also	have	the	option	to	make	your	icons	Large,	Small,	or	show	the	Detailed	view.3Current	ViewThis	section	has	some	interesting
options.	You	can	determine	the	way	your	files	and	folders	are	sorted.	To	sort,	click	the	Sort	by	drop-down.	4Show/hideThe	Show/hide	section	provides	quick	access	to	Show	or	Remove	Item	Check	boxes:	If	you	check	the	box	beside	Item	Check	boxes,	a	check	box	shows	left	of	the	Name	column.	You	can	then	check	the	box	on	top	to	check	all
items.The	Show/hide	section	also	provides	option	to	Hide	selected	items.Finally,	on	Options	in	the	View	tab,	you	can	configure	folder	options.	To	do	this,	click	the	Options	drop-down	and	select	Change	folder,	and	search	options.	This	will	open	Folder	Options.	File	Explorer	keyboard	shortcuts	is	yet	another	hot	topic	a	lot	of	users	want	to	get	help.	The
table	below	details	the	available	keyboard	shortcuts	and	what	you	achieve	with	them.	To	use	a	keyboard	shortcut,	press	the	keys	simultaneously.	I	recommend	you	open	File	Explorer	and	try	each	of	the	keyboard	short	to	see	them	in	action!	S/NFile	Explorer	Keyboard	Shortcut	Actions	Performed	by	the	Keyboard	Shortcut1Ctrl	+	WClose	the	active
window.	The	active	window	is	the	window	you	are	currently	viewing2Ctrl	+	NOpen	a	new	window.	If	you	use	this	shortcut	with	a	folder	open,	another	window	of	the	folder	will	open.	However,	if	you	press	the	shortcut	with	a	file	active	–	say	notepad	–	a	new	file	will	open3Ctrl	+	FOpens	the	File	Explorer	search	box.	This	shortcut	opens	the	search	box
for	the	open	application.	For	example,	if	you	are	on	a	webpage	when	you	press	this	shortcut,	it	opens	a	search	box	on	the	top	right	of	the	webpage.	4Ctrl	+	ESimilar	to	Ctrl	+	F	–	opens	the	search	box.	5Alt	+	DSelect	the	address	bar.	If	you	are	on	File	Explorer,	it	selects	the	address	bar	of	File	Explorer.	However,	if	you	are	on	a	webpage,	it	selects	the
address	bar	of	the	webpage.	6Ctrl	+	mouse	scroll	wheelChange	the	size	and	appearance	of	file	and	folder	icons.	7Ctrl	+	Shift	+	EDisplay	all	folders	above	the	selected	folder.	8Ctrl	+	Shift	+	NThis	keyboard	shortcut	creates	a	new	folder.	This	can	be	very	helpful.	Instead	of	going	through	3	steps	to	create	a	new	folder,	you	can	do	it	in	a	single
step!9Num	Lock	+	asterisk	(*)Display	all	subfolders	under	the	selected	folder.	10Alt	+	Left	arrowUsed	to	view	the	previous	folder.11Alt	+	Up	arrowView	the	folder	that	the	current	folder	was	in.12Alt	+	Right	arrowView	the	next	folder.13Alt	+	EnterOpen	the	Properties	dialog	box	for	the	selected	item.	This	works	for	Folders	or	Files.	14Alt	+	PThis
shortcut	displays	the	preview	panel	on	the	right	pane	of	File	Explorer.	Note	that	some	items	may	not	have	a	preview.	15Num	Lock	+	minus	(-)Collapse	the	selected	folder.16Num	Lock	+	plus	(+)Display	the	contents	of	the	selected	folder.17F11	keyMaximize	or	minimize	the	open	window.	18Home	keyDisplay	the	top	of	the	open	window.19End
keyDisplay	the	bottom	of	the	open	window.20Left	arrow	keyIf	the	current	selection	is	expanded,	it	collapses	it,	or,	it	selects	the	folder	the	current	folder	is	in.	21Right	arrow	keyIf	the	current	selection	is	collapsed,	it	expands	it,	or,	it	selects	the	first	subfolder.	22Backspace	keyView	the	previous	folder.	Now	that	you	know	how	to	open	File	Explorer	in
Windows	10,	the	next	important	topic	you	need	to	get	help	for	in	File	Explorer	is	“Quick	access”	customization.	As	explained	in	the	last	section,	by	default	when	you	open	File	Explorer	in	Windows	10,	it	opens	in	“Quick	access”.	Want	to	become	more	productive?	One	way	is	to	set	up	Windows	10	File	Explorer	to	display	commonly	used	items	in	“Quick
access”.	For	instance,	if	you	open	a	folder	often,	you	can	“Pin”	it	to	“Quick	access”	to	make	it	easy	to	find.	To	pin	a	folder	to	“Quick	access”,	right-click	the	folder	and	select	Pin	to	Quick	access.	The	folder	will	appear	beneath	Quick	access	immediately	–	see	the	second	screenshot	below.	Other	important	File	Explorer	items	you	can	“Pin”	to	Quick
access	are	“This	PC”,	and	“Network”.	Like	a	folder,	to	“Pin”	any	of	these	items,	right-click	the	item	and	select	Pin	to	Quick	access.	See	the	images	below.	Another	important	task	in	our	get	help	with	File	Explorer	in	Windows	10	guide	is	to	show	you	how	to	“Unpin”	File	Explorer	Items	To	“Quick	access”.	Our	work	changes,	so	do	the	File	Explorer	items
we	access	often.	If	you	want	to	remove	an	item	from	Quick	access,	follow	the	steps	below:	Right-click	Start	Menu	and	select	File	Explorer.	When	File	Explorer	opens	in	Quick	access,	right-click	the	item	you	want	to	“Unpin”	from	“Quick	access”.	Then,	from	the	displayed	options,	select	Unpin	from	Quick	access.	Another	important	Windows	10	File
Explorer	feature	you	may	need	to	get	help	for	is	the	File	Explorer	Privacy	settings.	This	setting	allows	you	to	remove	“Frequent	Folders”	and/or	“Recent	Files”	From	“Quick	access”.	These	2	features	are	highlighted	in	the	screenshot	below.	To	stop	Quick	access	displaying	“Frequent	Folders”	and/or	“Recent	Files”,	follow	the	steps	below:	On	the	search
box,	type	file	explorer	options.	Then,	from	the	search	result,	select	File	Explorer	Options.	When	File	Explorer	Options	opens,	locate	the	Privacy	section.	Then,	uncheck	Show	recently	used	files	in	Quick	access	and/or	Show	frequently	used	folders	in	Quick	access.	Once	you	have	competed	the	actions,	to	save	your	changes,	click	OK.	Now	if	you	open	File
Explorer	Quick	access,	Recent	Files	and	Frequent	Folders	will	no	longer	be	displayed.	Most	users	also	want	to	get	help	with	File	Explorer	in	Windows	10	by	learning	how	to	open	“My	Documents”.	In	Windows	10,	“My	Documents”	has	changed	to	“Documents”.	There	are	2	ways	you	can	access	this	important	File	Explorer	item.	From	File	Explorer
Quick	access:	by	default,	“Documents”	is	pinned	to	Quick	access.	If	you	open	File	Explorer	in	Quick	access	(default),	you	can	access	Documents	beneath	Quick	access.	However,	if	you	previously	unpinned	“Documents”	from	Quick	access,	follow	the	steps	below	to	open	“Documents”:	Open	File	Explorer:	right-click	Start	Menu	and	click	it.	When	File
Explorer	opens,	on	the	left	pane,	click	This	PC	(In	Windows	7,	this	was	called	My	Computer).	Then,	on	This	PC,	click	open	your	drive	C	or	the	drive	your	Windows	10	is	installed.	Finally,	open	the	Users	folder,	then,	open	the	folder	with	your	Windows	10	login	name	–	your	“Documents	will	be	located	in	that	folder.	To	make	it	easier	to	open	Documents
next	time,	right-click	it	and	select	Pin	to	Quick	access.	This	is	yet	another	area	users	want	to	get	help	with	File	Explorer	in	Windows	10.	In	this	section,	I	will	show	you	how	to	import	photos	and	videos	from	an	Android	phone	or	iPhone.	Connect	your	phone	to	your	computer	with	the	USB	cable	that	came	with	the	phone	–	or	any	other	compatible	USB
cable.	Whether	you	connect	an	iPhone	or	Android	phone	to	your	Windows	10	PC,	unlock	your	phone.	Then,	for	an	iPhone,	a	pop-up	will	be	displayed	asking	you	to	“Allow	this	device	to	access	photos	and	videos”.	Tap	Allow.	For	an	Android	phone,	after	unlocking	the	phone,	swipe	down	(top	to	the	button)	to	display	notifications.	When	the	notifications
window	opens,	scroll	down	to	Android	System	USB	Charging.	Finally,	beneath	USB	Charging,	tap	Tap	for	other	USB	options.	Then,	select	the	options	shown	in	the	second	screenshot	below.	Before	you	proceed	with	the	steps	in	this	section,	ensure	that	you	have	completed	the	steps	in	the	previous	sub-section	–	How	To	Connect	Your	Android	or	iPhone
To	Your	PC.	Search	file	explorer	and	open	it.	Then,	on	the	left	pane	of	File	Explorer,	click	This	PC.	Moving	on,	when	This	PC	opens,	your	phone	will	be	displayed.	To	access	the	files	on	your	phone,	double-click	the	phone’s	storage	icon.	When	you	open	the	phones,	they	will	be	displayed	as	shown	below.	Double-click	the	phone	storage.	For	iPhone,	the
next	window	will	display	the	DCIM	folder	(see	the	left	part	of	the	screenshot).	However,	for	an	Android	phone,	it	displays	other	folders,	including	the	DCIM	folder.	Click	the	DCIM	folder.	Finally,	on	the	left	pane	of	the	image	below,	your	iPhone	will	display	the	photo	folders.	To	view	and	copy	the	photos,	open	any	of	the	folders.	However,	for	your
Android	phone,	the	photos	folder	is	displayed	as	Cameras.	To	view	and	copy	the	photos,	open	the	Camera	folder.	There!	You	have	your	help	with	importing	photos	to	Windows	10	with	File	Explorer!	To	learn	how	to	import	photos	to	Windows	10	photos	App,	read	our	guide	–	How	To	Import	Photos	From	A	Phone	To	Windows	10	Photos	App.	Another	File
Explorer	feature	users	want	to	get	help	with,	in	Windows	10	is	setting	up	OneDrive.	This	section	offers	step	by	step	guide	to	set	up	OneDrive.	Here	are	the	steps	to	setup	OneDrive	in	Windows	10.	On	the	search	box	of	your	Windows	10,	enter	onedrive.	Then,	select	the	app	from	the	search	results.	Then,	on	the	first	setup	screen,	enter	your	email
address	and	click	Sign	in.	If	you	do	not	have	a	Microsoft	account,	enter	your	email	address	and	click	Create	account.	On	the	Enter	Password	page,	enter	the	password	to	the	Microsoft	account.	Then,	click	Sign	in.	Then,	wait	for	the	sign-in	to	complete	and	load	the	next	page.	If	you	created	an	OneDrive	folder	as	I	recommended	at	the	beginning	of	this
section,	at	the	bottom	of	the	screen,	click	Change	location	and	select	the	folder	you	created	earlier.	Otherwise,	to	use	the	default	location,	click	Next.	On	the	next	page,	Microsoft	may	try	to	sell	you	Office	365	as	part	of	the	OneDrive	Premium	upgrade.	If	you	wish	to	upgrade,	click	Go	premium.	Otherwise,	click	Now	now.	From	this	point,	click	Next
several	times	until	you	get	to	the	option	to	Open	my	OneDrove	folder.	The	tasks	covered	in	this	section	are	based	on	questions	asked	by	our	readers	in	the	first	version	of	get	help	with	file	explorer	in	Windows	10	article.	If	you	are	in	File	Explorer	and	want	to	print	a	document	or	file,	right-click	the	file	or	document.	Then,	from	the	displayed	options,
select	Print.	Alternatively,	you	can	print	multiple	files	or	documents.	To	print	more	than	one	document	or	file,	select	the	first	file	by	left-clicking	on	it.	With	the	first	document	selected,	press	the	Ctrl	key	on	your	keyboard.	Then,	click	all	documents	you	want	to	print	together	–	to	select	them.	Finally,	right-click	one	of	the	selected	documents	and	select
Print.	Once	you	click	Print,	the	documents	will	print	to	your	default	printer.	Windows	10	File	Explorer	does	not	have	a	photo/image	resize	options.	However,	the	Windows	10	Photos	App	has	a	resize	option.	To	open	the	Photos	App,	type	photos	in	Windows	10	search.	Then	click	the	app	from	the	search	results.	Next,	you	need	to	import	the	photo	you
want	to	resize.	To	import	the	photo,	on	the	top	right	of	the	Photos	app,	click	Import.	Then,	select	where	your	photo	is	located	and	complete	the	import.	The	next	step	is	to	resize	the	photo.	First,	click	on	the	photo	to	open	it.	Then,	right-click	the	photo	and	select	Resize.	Finally,	if	available,	select	a	pre-defined	size	–	S,	M,	or	L.	Alternatively,	click	Define
custom	dimensions.	This	is	another	feature	some	of	our	readers	wants	to	get	help	with	in	windows	10	File	Explorer.	There	are	2	ways	to	delete	a	photo	in	File	Explorer	–	right-click	the	photo	and	select	delete.	Alternatively,	you	can	select	the	photo	–	by	left-clicking	it.	Then,	on	your	keyboard,	press	the	Ctrl	and	D	keys	simultaneously.	Additionally,	if
you	wish	to	delete	a	photo	from	the	Photos	App:	Hover	over	the	photo	you	wish	to	delete	from	the	Photos	app	–	then,	check	the	square	box	displayed	on	the	top	right	of	the	photo.	If	you	want	to	delete	multiple	photos,	repeat	step	1	for	all	the	photos	you	wish	to	delete.	With	all	the	photos	selected,	on	the	top	right	of	the	photos	app,	click	the	delete	icon.
You	will	receive	a	pop-up	requesting	you	to	confirm	the	delete.	To	save	any	file	in	Windows	10	–	Word,	Excel,	Text	file	–	on	the	top	left	of	the	file,	click	File.	Then,	from	the	displayed	options,	select	Save	or	Save	As.	Some	of	our	readers	also	complained	that	when	they	open	File	Explorer,	it	displays	the	names	of	the	files.	These	readers	want	to	get	help
setting	up	Windows	10	File	Explorer	to	display	folders	in	Thumbnail	View.	Follow	the	steps	below	to	change	your	File	Explorer	view	to	thumbnail.	On	the	menu	of	File	Explorer,	click	the	View	tab.	Finally,	on	the	Layout	section	of	the	File	Explorer	View	tab,	select	either	Large	icons,	or	Extra	Large	icons.	How	to	Increase	File	Explorer	Text	Size	One
quick	way	to	increase	the	text	of	File	Explorer	texts	is	to	change	the	view	to	thumbnail	–	click	the	View	tab,	then	select	Extra	Large	icons.	However,	this	changes	the	view.	If	you	want	to	increase	just	the	text	size,	see	the	steps	below	this	screenshot.	Earlier	version	of	Windows	10	has	a	display	setting	“Advanced	sizing	of	text	and	other	items”.
Unfortunately,	this	feature	has	been	removed.	The	good	news	is	that	we	can	still	use	the	”	Ease	of	Access”	feature	to	make	the	text	in	File	Explorer	bigger.	The	only	downside	is	that	it	makes	the	text	in	every	other	part	of	Windows	10	bigger	as	well.	Follow	the	steps	below	to	increase	the	text	size	of	the	names	of	items	in	File	Explorer.	Search	ease	of
access.	Then,	select	Ease	of	Access	brightness	setting.	Finally,	drag	the	slider	beneath	Sample	text	and	click	Apply.	This	is	yet	another	popular	Windows	10	File	Explorer	topic	users	want	to	get	help	with.	The	fastest	way	to	open	File	Explorer	Options	is	to	search	File	Explorer	Options.	You	can	also	open	File	Explorer	Options	from:	Control	Panel	(View
by:	Small	icons)->	File	Explorer	Options.	From	File	Explorer	View	tab	->	Options	->	Change	folder	and	search	options.	Windows	10	File	Explorer	has	a	preview	pane.	If	enabled,	when	you	click	on	a	document,	the	preview	pane	displays	a	preview	of	the	content	of	the	document.	Follow	the	steps	to	enable	File	Explorer	Preview	Pane:	Open	any	folder	on
your	computer.	Then,	on	the	top	right	of	the	folder,	click	the	arrow	pointing	downwards.	Next,	click	the	View	tab.	Finally,	to	enable	the	File	Explorer	preview	pane	in	Windows	10,	on	the	Panes	section	of	the	View	tab,	click	Preview	pane.	Once	you	enable	Preview	pane,	if	you	click	a	document,	File	Explorer	will	display	a	preview	of	the	document.	1.
Files/folders	known	to	be	in	the	computer	are	now	missing	from	File	Explorer,	how	do	I	get	them	back?	The	most	likely	reason	files	you	used	to	view	in	File	Explorer	may	now	be	missing	is	likely	that	the	files/folders	are	hidden.	Furthermore,	you	may	have	changed	the	hidden	files	view	setting	in	Folder	Options.	To	display	all	files	–	hidden	and
unhidden,	click	the	View	tab	in	File	Explorer.	Then,	click	Options	->	Change	folder	and	search	options.	On	Folder	Options,	click	the	View	tab.	Finally,	select	Show	hidden	files,	folders	and	drives	and	click	OK.	2.	My	File	Explorer	just	shows	numbers	and	dates.	How	do	I	change	it	to	View	pictures?	Click	the	View	tab	of	File	Explorer.	Then,	on	the	Layout
section	of	the	View	tab,	click	Extra	Large	icons,	or	Large	icons.	3.	Every	time	I	click	‘Print’,	I	get	a	pop-up	‘Save	Print	Output	As’.	How	do	I	Print	to	my	printer?	The	reason	you	get	‘Save	Print	Output	As’	instead	of	printing	to	your	printer	is	because	your	default	printer	is	set	to	Microsoft	Print	to	PDF,	instead	of	an	actual	printer.	To	change	your	default
printer	to	a	printer,	search	printers.	Then	select	Printers	&	scanners.	Then,	from	the	list	of	printers,	click	on	the	printer	you	want	to	make	default	and	select	Open	queue.	Finally,	on	the	printer	queue,	click	Printer	and	select	Set	As	Default	Printer.	Now,	if	you	print,	it	will	print	to	your	printer.	4.	I	received	the	notification	“Files	are	waiting	to	be
written	to	CD”.	What	do	I	do	to	write	them?	Search	%AppData%	and	open	the	folder.	Then	from	the	AppData	folder	navigate	to	Local\Microsoft\Windows\Burn.	Finally,	right-click	the	Temporary	Burn	Folder	and	select	delete.	Restart	your	computer	and	try	writing	files	to	your	DVD	or	CD.	5.	I	lost	my	print	icon	and	can’t	print	my	Photos.	Where	did	it
go	and	how	do	I	get	it	back?	Fix	1:	Search	Microsoft	Store	and	open	it.	Then,	on	the	top	right	of	the	Microsoft	Store	app,	click	the	3	dots	and	select	Downloads	and	updates.	Finally,	click	Get	updates	–	when	the	updates	are	downloaded,	see	whether	there	is	an	update	for	the	Photos	app	and	update	it.	Fix	2:	If	updating	the	photos	app	does	not	work	or
there	is	no	update,	check	for	Windows	10	update:	Right-click	Start	Menu	and	select	Settings.	Then	open	Update	&	Security	->	Check	for	updatesFix	3:	Open	the	command	prompt	as	administrator	(link	opens	in	a	new	browser	tab).	Then,	type	these	commands	and	press	the	enter	key	–	wait	for	the	first	command	to	complete	before	executing	the
second	command:	SFC	/scannowDISM.exe	/Online	/Cleanup-Image	/RestorehealthWhen	both	commands	are	complete,	restart	your	computer.	Then	check	whether	the	print	option	is	back	on	the	Photos	app.	6.	How	do	I	get	to	File	Explorer	Options	in	Windows	10?	Enter	File	Explorer	Options	in	the	Windows	10	search	box.	Then,	open	File	Explorer
Options.	7.	How	do	I	change	the	appearance	of	File	Explorer	in	Windows	10?	On	the	File	Explorer	menu,	click	the	View	tab.	Then,	on	the	Layout	section	of	the	View	tab,	select	the	new	File	Explorer	appearance	–	Extra	Large	icons,	Large	icons,	Medium-Sized	icons,	Small	icons,	List,	or,	Details.	8.	How	do	I	make	File	Explorer	look	normal?	From	File
Explorer	View	tab	->	Options	->	Change	folder	and	search	options.	Then,	on	the	General	tab,	click	Restore	Defaults.	Also,	click	the	View	tab	and	click	Restore	Defaults.	Finally,	click	the	Search	tab	and	click	Restore	Defaults.	9.	Why	did	Microsoft	remove	File	Explorer	from	Xbox	One	Consoles?	Microsoft	explained	that	File	Explorer	was	removed	from
Xbox	One	consoles	due	to	“limited	usage.”	10.	What	is	File	Explorer	in	Windows	10?	File	Explorer	(replaced	Windows	7	Windows	Explorer)	is	an	app	that	allows	you	to	browse	files	and	folders	in	Windows	10.	It	gives	you	access	to	access	files	saved	on	your	computer.	I	hope	you	were	able	to	get	help	with	File	Explorer	in	Windows	10	–	with	this	long
guide?	I	also	hope	you	found	the	guide	helpful.	If	you	found	this	Windows	10	guide	helpful,	kindly	spare	2	minutes	to	share	your	experience	with	our	community	using	the	comments	form	(“Leave	a	Reply”)	at	the	bottom	of	this	page.	Alternatively,	you	can	respond	to	the	“Was	this	page	helpful?”	question	below.	Finally,	for	more	Windows	10
Itechguides,	visit	our	Windows	10	How-To	page.	You	may	also	find	our	other	File	Explorer	guides	helpful.	Was	this	page	helpful?	Yes	(29)No	(28)	About	the	Author	Victor	Ashiedu	Related	Articles	We're	committed	to	writing	accurate	content	that	informs	and	educates.	To	learn	more,	read	our	Content	Writing	Policy,	Content	Review	Policy,	Anti-
plagiarism	Policy,	and	About	Us.	However,	if	this	content	does	not	meet	your	expectations,	kindly	reach	out	to	us	through	one	of	the	following	means:	Respond	to	"Was	this	page	helpful?"	above	Leave	a	comment	with	the	"Leave	a	Comment"	form	below	Email	us	at	[email	protected]	or	via	the	Contact	Us	page.	Windows	File	Explorer	serves	as	your
gateway	to	managing	files	and	folders	on	your	computer.	When	it	stops	working	properly,	your	entire	workflow	comes	to	a	halt.	This	comprehensive	guide	provides	practical	solutions	to	common	File	Explorer	problems	and	shows	you	where	to	find	help	when	you	need	it	most.	File	Explorer	is	Windows’	built-in	file	management	application	that	lets	you
browse,	organize,	and	access	files	on	your	computer.	It’s	essentially	your	digital	filing	cabinet,	helping	you	navigate	through	folders,	copy	files,	and	manage	your	storage	space	efficiently.	Every	Windows	user	interacts	with	File	Explorer	daily,	whether	they’re	opening	documents,	managing	downloads,	or	organizing	photos.	When	File	Explorer
malfunctions,	it	affects	your	ability	to	perform	basic	computer	tasks,	making	quick	resolution	crucial	for	productivity.	File	Explorer	consists	of	several	key	elements	that	work	together	to	provide	file	management	functionality:	ComponentFunctionCommon	IssuesNavigation	PaneShows	folder	hierarchySlow	loading,	missing	drivesAddress	BarDisplays
current	locationPath	errors,	navigation	problemsRibbon	MenuProvides	file	operationsUnresponsive	buttons,	missing	optionsPreview	PaneShows	file	contentCrashes,	memory	issuesStatus	BarDisplays	file	informationIncorrect	data,	performance	metrics	Understanding	these	components	helps	you	identify	where	problems	originate	and	apply	targeted
solutions.	File	Explorer	is	built	into	Windows	and	doesn’t	have	separate	system	requirements.	However,	optimal	performance	depends	on	your	system	specifications:	RequirementMinimumRecommendedRAM2GB8GB	or	moreStorage500MB	free	space2GB	free	spaceProcessor1GHz2GHz	dual-coreGraphicsDirectX	9	compatibleDirectX	11	compatible
Systems	below	minimum	requirements	may	experience	slow	performance,	frequent	crashes,	or	limited	functionality	in	File	Explorer.	“This	Computer”	provides	direct	access	to	your	drives,	network	locations,	and	system	folders.	It	serves	as	the	central	hub	for	all	storage	devices	connected	to	your	system.	Open	File	Explorer	and	click	“This	PC”	in	the
navigation	pane	to	access	your	computer’s	drives	and	folders.	You	can	also	set	This	PC	as	your	default	File	Explorer	location	through	Folder	Options.	Personalizing	the	This	Computer	view	improves	your	workflow	and	provides	quick	access	to	frequently	used	locations.	You	can	add	custom	folders,	remove	unnecessary	items,	and	reorganize	the	layout.
Right-click	empty	space	in	This	Computer	and	select	“Personalize”	to	modify	the	appearance.	Add	network	drives	by	clicking	“Map	network	drive”	in	the	Computer	tab	of	the	ribbon	menu.	Network	locations	appear	in	This	Computer	alongside	local	drives,	providing	seamless	access	to	shared	folders	and	cloud	storage.	This	integration	simplifies	file



management	across	multiple	storage	systems.	Click	“Add	a	network	location”	in	This	Computer	to	connect	to	FTP	sites,	web	folders,	or	other	network	resources.	These	connections	persist	across	sessions	and	appear	automatically	when	File	Explorer	opens.	File	Explorer	cannot	be	downloaded	as	a	standalone	application	because	it’s	integrated	into
Windows	as	a	core	system	component.	It’s	included	with	every	Windows	installation	and	cannot	be	removed	or	replaced	entirely.	If	File	Explorer	is	missing	or	corrupted,	you	need	to	repair	or	reinstall	Windows	components	rather	than	downloading	a	separate	installer.	Microsoft	doesn’t	provide	File	Explorer	as	an	independent	download.	When	File
Explorer	becomes	severely	corrupted,	reinstalling	its	components	through	Windows	Features	or	system	repair	tools	often	resolves	persistent	problems.	Open	“Turn	Windows	features	on	or	off”	through	Control	Panel,	locate	“Windows	Search”	and	related	components,	uncheck	them,	restart	your	computer,	then	re-enable	these	features.	This	process
reinstalls	File	Explorer	dependencies.	See	also		NovelAI	vs	AI	Dungeon:	A	Detailed	Comarison	2025	Some	File	Explorer	functionality	depends	on	optional	Windows	features	that	may	not	be	installed	by	default.	Installing	these	features	can	resolve	missing	menu	options	or	functionality	gaps.	Access	Windows	Features	through	Control	Panel	>	Programs
>	Turn	Windows	features	on	or	off.	Enable	features	like	“Windows	Search,”	“Internet	Explorer,”	and	“Media	Features”	to	ensure	full	File	Explorer	functionality.	File	Explorer	failing	to	open	prevents	access	to	your	files	and	folders,	creating	significant	workflow	disruption.	This	problem	typically	occurs	due	to	corrupted	system	files,	registry	errors,	or
conflicting	software.	When	File	Explorer	won’t	open,	try	pressing	Windows	+	R,	typing	“explorer.exe,”	and	pressing	Enter.	If	this	fails,	the	explorer.exe	process	may	be	corrupted	and	require	repair	through	system	tools.	Unresponsive	File	Explorer	windows	freeze	your	file	management	activities	and	may	require	forceful	closure.	This	issue	often	stems
from	memory	problems,	corrupted	files,	or	excessive	system	load.	The	explorer.exe	process	manages	File	Explorer	windows	and	the	desktop	environment.	When	this	process	encounters	errors,	it	affects	system	stability	and	file	management	capabilities.	Monitor	explorer.exe	in	Task	Manager	to	identify	unusual	behavior	like	high	CPU	usage	or	memory
consumption.	Multiple	explorer.exe	processes	may	indicate	malware	infection	or	system	corruption.	Quick	Access	problems	prevent	File	Explorer	from	displaying	recent	files	and	frequently	used	folders.	These	issues	often	result	from	corrupted	history	files	or	indexing	problems.	Clear	Quick	Access	history	and	disable	automatic	folder	suggestions	if
problems	persist.	Rebuild	the	search	index	through	Indexing	Options	in	Control	Panel	to	restore	Quick	Access	functionality.	Corrupted	explorer.exe	files	cause	File	Explorer	crashes,	desktop	problems,	and	system	instability.	Repairing	these	files	requires	administrative	access	and	system	repair	tools.	Run	Command	Prompt	as	administrator	and
execute	“sfc	/scannow”	to	scan	and	repair	corrupted	system	files	including	explorer.exe.	This	process	automatically	replaces	damaged	files	with	clean	copies	from	Windows	installation	media.	Manual	system	file	replacement	provides	targeted	repair	for	specific	explorer.exe	problems	when	automatic	tools	fail.	This	advanced	technique	requires	careful
execution	to	avoid	system	damage.	Boot	from	Windows	installation	media,	access	Command	Prompt,	and	navigate	to	the	System32	folder.	Replace	corrupted	explorer.exe	with	a	clean	copy	from	the	Windows	installation	source.	Registry	corruption	affects	explorer.exe	functionality	and	File	Explorer	behavior.	Repairing	registry	entries	related	to	File
Explorer	often	resolves	persistent	problems.	Use	Registry	Editor	to	navigate	to	HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer	and	verify	key	integrity.	Export	registry	keys	before	making	changes	to	enable	rollback	if	problems	occur.	Proper	File	Explorer	configuration	improves	performance,	security,	and	usability.
These	essential	settings	form	the	foundation	of	an	efficient	file	management	environment.	Setting	CategoryKey	OptionsImpactView	OptionsShow	hidden	files,	file	extensionsSecurity,	troubleshootingPrivacy	SettingsClear	history	on	exitPrivacy	protectionSearch	OptionsIndex	locations,	file	typesSearch	performanceNavigationDefault	folder,	Quick
AccessWorkflow	efficiency	File	Explorer	privacy	settings	control	what	information	is	stored	and	shared	about	your	file	usage	patterns.	Proper	configuration	protects	sensitive	data	while	maintaining	functionality.	Disable	“Show	recently	used	files	in	Quick	access”	and	“Show	frequently	used	folders	in	Quick	access”	to	prevent	unauthorized	access	to
your	file	history.	Clear	File	Explorer	history	regularly	to	maintain	privacy.	Advanced	folder	options	provide	granular	control	over	File	Explorer	behavior	and	appearance.	These	settings	affect	how	files	are	displayed,	accessed,	and	managed	across	your	system.	Enable	“Display	the	full	path	in	the	title	bar”	and	“Show	status	bar”	for	better	navigation
awareness.	Configure	“Open	each	folder	in	its	own	window”	if	you	prefer	multiple	File	Explorer	instances.	Effective	file	organization	reduces	search	time	and	improves	productivity.	Implement	consistent	naming	conventions,	logical	folder	structures,	and	regular	maintenance	routines.	Create	a	hierarchy	no	more	than	three	levels	deep	to	maintain
accessibility.	Use	descriptive	folder	names	that	clearly	indicate	contents	without	being	excessively	long.	File	Explorer’s	search	functionality	goes	beyond	simple	filename	matching.	Master	advanced	search	operators	and	filters	to	locate	files	quickly	across	large	storage	systems.	Search	OperatorFunctionExampletype:Search	by	file
typetype:pdfmodified:Search	by	date	modifiedmodified:todaysize:Search	by	file	sizesize:>10MBauthor:Search	by	file	authorauthor:John	Batch	operations	allow	you	to	perform	actions	on	multiple	files	simultaneously,	saving	significant	time	when	managing	large	file	collections.	File	Explorer	supports	various	batch	operations	through	selection	and
keyboard	shortcuts.	Select	multiple	files	using	Ctrl+click	or	Shift+click,	then	apply	operations	like	copy,	move,	delete,	or	rename	to	all	selected	items.	Use	F2	to	rename	multiple	files	with	sequential	numbering.	File	Explorer	contains	numerous	hidden	features	that	enhance	productivity	and	provide	advanced	functionality.	Discovering	these	features
transforms	your	file	management	experience.	Press	Alt	to	reveal	classic	menu	options	in	File	Explorer.	Use	Ctrl+Shift+N	to	create	new	folders	quickly.	Right-click	the	File	Explorer	icon	in	the	taskbar	while	holding	Shift	to	access	advanced	options.	Quick	Access	learns	from	your	usage	patterns	to	provide	intelligent	file	and	folder	suggestions.
Optimizing	this	feature	improves	workflow	efficiency	while	maintaining	system	performance.	Pin	frequently	used	folders	to	Quick	Access	for	permanent	placement.	Unpin	rarely	used	items	to	keep	the	list	relevant	and	manageable.	Preview	and	Details	panes	provide	additional	information	about	selected	files	without	opening	them.	These	panes
enhance	productivity	by	displaying	file	contents	and	metadata	inline.	Enable	Preview	Pane	through	the	View	tab	to	see	document	contents,	image	previews,	and	media	information.	Use	Details	Pane	to	access	file	properties,	tags,	and	system	information.	File	Explorer	freezing	or	becoming	unresponsive	is	the	most	frequent	issue	Windows	users
encounter.	This	problem	typically	manifests	as	a	greyed-out	window	that	doesn’t	respond	to	clicks	or	keyboard	inputs.	The	root	causes	often	include	corrupted	system	files,	conflicting	software,	or	excessive	memory	usage.	When	File	Explorer	stops	responding,	your	immediate	options	are	limited,	but	several	recovery	methods	can	restore	functionality
without	requiring	a	system	restart.	Performance	degradation	in	File	Explorer	creates	frustrating	delays	when	browsing	folders	or	opening	files.	This	sluggishness	often	stems	from	indexing	problems,	too	many	startup	programs,	or	insufficient	system	resources.	File	Explorer	consuming	excessive	RAM	indicates	underlying	issues	with	system	processes
or	corrupted	files.	High	memory	usage	slows	down	your	entire	computer	and	may	cause	other	applications	to	crash.	Monitor	your	Task	Manager	to	identify	when	File	Explorer	uses	more	than	100MB	of	RAM	consistently.	Normal	usage	should	keep	memory	consumption	below	50MB	for	typical	file	browsing	activities.	Working	with	large	files	or	folders
containing	thousands	of	items	often	triggers	performance	problems.	File	Explorer	struggles	to	generate	thumbnails,	calculate	folder	sizes,	and	display	file	information	for	extensive	collections.	Consider	organizing	large	folders	into	smaller	subfolders	and	disable	thumbnail	generation	for	folders	with	many	media	files	to	improve	performance.
Restarting	the	File	Explorer	process	resolves	most	temporary	glitches	without	requiring	a	full	system	reboot.	This	method	clears	memory	issues	and	refreshes	system	connections.	Press	Ctrl	+	Shift	+	Esc	to	open	Task	Manager,	find	“Windows	Explorer”	in	the	Processes	tab,	right-click	it,	and	select	“Restart.”	Your	desktop	will	briefly	disappear	before
returning	to	normal	operation.	Alternatively,	hold	Ctrl	+	Shift	while	right-clicking	the	taskbar,	then	select	“Exit	Explorer”	from	the	context	menu.	Open	Task	Manager,	click	“File,”	select	“Run	new	task,”	type	“explorer.exe,”	and	press	Enter.	File	Explorer	maintains	a	history	of	recently	accessed	files	and	folders	to	provide	quick	access	through	Quick
Access.	However,	this	history	can	become	corrupted	and	cause	performance	issues.	Open	File	Explorer,	click	“View”	in	the	ribbon	menu,	select	“Options,”	and	click	“Clear”	next	to	“Clear	File	Explorer	history.”	This	action	removes	all	Quick	Access	entries	and	recent	file	references.	Quick	Access	attempts	to	predict	which	files	you’ll	need	next,	but	this
feature	can	slow	down	File	Explorer	significantly.	Disabling	Quick	Access	often	improves	performance,	especially	on	older	computers.	Navigate	to	File	Explorer	Options,	change	the	“Open	File	Explorer	to”	setting	from	“Quick	access”	to	“This	PC.”	This	modification	forces	File	Explorer	to	open	directly	to	your	drives	instead	of	generating	Quick	Access
suggestions.	Corrupted	folder	options	cause	various	display	and	functionality	problems	in	File	Explorer.	Resetting	these	options	returns	settings	to	default	values	and	often	resolves	persistent	issues.	Open	File	Explorer,	click	“View,”	select	“Options,”	and	click	“Reset	Folders”	in	the	Folder	Options	dialog.	Confirm	the	action	and	restart	File	Explorer	to
apply	changes.	System	File	Checker	scans	your	computer	for	corrupted	Windows	files	and	automatically	repairs	them.	Many	File	Explorer	problems	stem	from	damaged	system	files	that	SFC	can	identify	and	fix.	Open	Command	Prompt	as	an	administrator	by	pressing	Windows	+	X	and	selecting	“Command	Prompt	(Admin).”	Type	“sfc	/scannow”	and
press	Enter.	The	scan	takes	15-30	minutes	and	requires	an	internet	connection	for	file	downloads.	SFC	will	report	its	findings	upon	completion.	If	it	discovers	corrupted	files,	it	attempts	automatic	repair.	Restart	your	computer	after	the	scan	completes	to	ensure	changes	take	effect.	Deployment	Image	Servicing	and	Management	(DISM)	provides
deeper	system	repair	capabilities	than	SFC.	Use	DISM	when	SFC	fails	to	resolve	File	Explorer	problems	or	reports	that	it	cannot	fix	certain	files.	See	also		Best	Practices	for	Opening	a	Joint	Savings	Account	2025Run	Command	Prompt	as	administrator	and	execute	“DISM	/Online	/Cleanup-Image	/RestoreHealth”	to	scan	and	repair	the	Windows	image.
This	process	takes	longer	than	SFC	but	addresses	more	complex	system	corruption.	Faulty	RAM	causes	various	File	Explorer	problems,	including	crashes,	slow	performance,	and	data	corruption.	Windows	Memory	Diagnostic	tests	your	computer’s	memory	for	errors	that	might	affect	File	Explorer	stability.	Press	Windows	+	R,	type	“mdsched.exe,”	and
press	Enter.	Select	“Restart	now	and	check	for	problems”	to	begin	the	memory	test.	Your	computer	will	restart	and	run	the	diagnostic	automatically.	Customizing	File	Explorer	improves	your	workflow	and	reduces	the	likelihood	of	problems.	Proper	configuration	enhances	performance	while	making	file	management	more	efficient.	Configure	the
ribbon	menu	to	show	only	the	tools	you	use	regularly.	Right-click	the	ribbon	and	select	“Customize	the	Ribbon”	to	add	or	remove	commands	based	on	your	needs.	Several	Windows	settings	directly	impact	File	Explorer	performance.	Adjusting	these	configurations	can	significantly	improve	response	times	and	stability.	SettingLocationRecommended
ValueVisual	EffectsSystem	Properties	>	PerformanceAdjust	for	best	performanceIndexing	OptionsControl	Panel	>	IndexingExclude	large	media	foldersPower	OptionsControl	Panel	>	PowerHigh	performance	modeWindows	SearchSettings	>	SearchDisable	enhanced	search	Proper	view	options	prevent	File	Explorer	from	consuming	excessive
resources	while	maintaining	functionality.	Configure	these	settings	based	on	your	typical	file	management	activities.	Disable	“Display	file	icon	on	thumbnails”	and	“Show	preview	handlers	in	preview	pane”	for	folders	containing	many	files.	These	features	consume	significant	memory	and	processing	power	when	dealing	with	large	collections.	Windows
includes	comprehensive	help	documentation	for	File	Explorer	and	other	system	components.	Access	this	resource	through	the	Start	menu	or	by	pressing	F1	while	File	Explorer	is	active.	The	built-in	help	system	provides	step-by-step	instructions	for	common	tasks	and	troubleshooting	procedures.	Use	the	search	function	to	find	specific	topics	related	to
your	File	Explorer	problems.	Microsoft	Community	forums	connect	you	with	other	Windows	users	and	Microsoft	support	staff	who	can	provide	personalized	assistance	with	File	Explorer	issues.	Visit	the	Microsoft	Community	to	search	existing	solutions	or	post	your	specific	problem.	Include	your	Windows	version,	error	messages,	and	steps	you’ve
already	tried	for	the	most	helpful	responses.	When	File	Explorer	continues	to	cause	problems	despite	troubleshooting	efforts,	third-party	file	managers	provide	reliable	alternatives	with	enhanced	features.	Popular	options	include	Total	Commander,	Directory	Opus,	and	FreeCommander.	These	applications	offer	advanced	file	management	capabilities
while	maintaining	compatibility	with	Windows	system	functions.	PowerShell	provides	command-line	file	management	capabilities	that	bypass	File	Explorer	entirely.	This	approach	works	well	for	users	comfortable	with	text-based	interfaces	who	need	reliable	file	operations.	Basic	PowerShell	commands	like	Get-ChildItem,	Copy-Item,	and	Move-Item
handle	most	file	management	tasks.	PowerShell	scripts	can	automate	repetitive	operations	and	provide	consistent	results	when	File	Explorer	becomes	unreliable.	Microsoft	regularly	releases	updates	that	improve	File	Explorer	stability	and	performance.	Installing	these	updates	promptly	prevents	many	common	problems	from	occurring.	Enable
automatic	updates	through	Windows	Update	settings	to	ensure	your	system	receives	the	latest	File	Explorer	improvements	and	security	patches.	Regular	disk	cleanup	prevents	storage	related	File	Explorer	problems	and	maintains	optimal	performance.	Use	Windows’	built-in	Disk	Cleanup	tool	monthly	to	remove	temporary	files	and	system	cache.
Schedule	automatic	disk	cleanup	through	Task	Scheduler	to	maintain	your	system	without	manual	intervention.	This	proactive	approach	prevents	many	File	Explorer	issues	before	they	impact	your	workflow.	File	Explorer	problems	can	significantly	impact	your	Windows	experience,	but	most	issues	have	straightforward	solutions.	Start	with	simple
fixes	like	restarting	the	File	Explorer	process	before	moving	to	advanced	troubleshooting	methods.	Regular	maintenance	and	proper	configuration	prevent	many	problems	from	occurring	in	the	first	place.	Remember	that	Microsoft	provides	extensive	help	resources,	and	the	Windows	community	offers	valuable	support	when	you	encounter	persistent
issues.	Don’t	hesitate	to	explore	alternative	file	management	solutions	if	File	Explorer	continues	to	cause	problems	despite	your	troubleshooting	efforts.	Start	by	restarting	the	File	Explorer	process	through	Task	Manager.	If	crashes	persist,	run	an	SFC	scan	to	check	for	corrupted	system	files.	Consider	disabling	unnecessary	File	Explorer	extensions
and	reducing	the	number	of	files	displayed	in	single	folders.	Disable	Quick	Access,	clear	File	Explorer	history,	and	reduce	visual	effects	in	Windows	settings.	Exclude	large	folders	from	Windows	Search	indexing	and	disable	thumbnail	generation	for	folders	containing	many	files.	High	memory	usage	often	results	from	corrupted	files,	too	many	open
windows,	or	problematic	extensions.	Restart	File	Explorer,	clear	its	history,	and	check	for	third-party	software	that	might	be	interfering	with	normal	operation.	Large	folders	with	many	files	and	enabled	thumbnail	generation	also	contribute	to	increased	memory	consumption.	Yes,	several	third-party	file	managers	can	replace	File	Explorer’s
functionality.	However,	some	Windows	features	depend	on	File	Explorer,	so	complete	replacement	may	cause	compatibility	issues	with	certain	applications.	Popular	alternatives	include	Total	Commander,	Directory	Opus,	and	Files	app	for	Windows	11.	Open	File	Explorer	Options	through	the	View	menu,	click	“Reset	Folders”	to	restore	default	folder
settings,	and	clear	File	Explorer	history.	For	complete	reset,	run	“ms-settings:appsfeatures”	from	Run	dialog,	find	Windows	Explorer,	and	select	Advanced	Options	to	reset.	Consider	creating	a	new	user	account	for	a	completely	fresh	File	Explorer	experience.	Persistent	explorer.exe	crashes	indicate	serious	system	problems.	Run	SFC	scan	and	DISM
repair	tools	to	fix	corrupted	system	files.	Check	for	malware	using	Windows	Defender	or	third-party	antivirus.	Disable	startup	programs	that	might	conflict	with	explorer.exe	and	consider	performing	a	system	restore	to	a	point	before	crashes	began.	Disable	visual	effects	through	Performance	Options,	reduce	the	number	of	indexed	locations,	and	turn
off	thumbnail	generation	for	large	folders.	Set	File	Explorer	to	open	to	This	PC	instead	of	Quick	Access,	disable	file	preview	for	media	files,	and	regularly	clean	temporary	files	to	maintain	optimal	performance	on	older	hardware.	File	Explorer	is	an	essential	tool	in	Windows	that	allows	users	to	browse,	manage,	and	organize	files	and	folders	efficiently.
If	you	are	experiencing	issues	or	need	assistance	using	File	Explorer,	this	guide	will	walk	you	through	everything	you	need	to	know	to	get	help	with	File	Explorer	in	Windows.What	is	File	Explorer	in	Windows?File	Explorer,	previously	known	as	Windows	Explorer,	is	a	built-in	file	management	application	in	Windows	operating	systems.	It	enables	users
to	navigate	the	file	system,	access	files,	and	perform	operations	like	copying,	moving,	renaming,	and	deleting	files.	Additionally,	it	provides	access	to	external	devices,	network	drives,	and	cloud	storage	services	like	OneDrive.How	to	Open	File	Explorer	in	WindowsThere	are	multiple	ways	to	open	File	Explorer	in	Windows:Using	the	Keyboard
Shortcut:	Press	Windows	+	E	to	open	File	Explorer	instantly.From	the	Taskbar:	Click	on	the	File	Explorer	icon	in	the	taskbar.Using	the	Start	Menu:	Click	on	the	Start	menu,	type	“File	Explorer,”	and	select	it.Using	the	Run	Command:	Press	Windows	+	R,	type	explorer,	and	hit	Enter.Via	Command	Prompt	or	PowerShell:	Open	Command	Prompt	(cmd)
or	PowerShell,	type	explorer,	and	press	Enter.Common	Issues	with	File	Explorer	and	How	to	Fix	ThemIf	you	are	facing	problems	with	File	Explorer,	here	are	some	common	issues	and	solutions:1.	File	Explorer	Not	Responding	or	FreezingPossible	Causes:Corrupt	system	filesOutdated	Windows	updatesOverloaded	cacheConflicting	third-party
applicationsSolution:Restart	your	computer.End	the	explorer.exe	process	in	Task	Manager	(Ctrl	+	Shift	+	Esc	>	Processes	>	Windows	Explorer	>	Restart).Clear	File	Explorer	history	(Go	to	File	Explorer	Options	>	Clear	history).Update	Windows	to	the	latest	version	(Settings	>	Update	&	Security	>	Windows	Update).Boot	into	Safe	Mode	and	check	if
the	issue	persists	(Windows	+	R	>	type	msconfig	>	Boot	tab	>	Safe	boot	>	Restart).2.	File	Explorer	Running	SlowSolution:Disable	Quick	Access:	Open	File	Explorer	Options,	set	“Open	File	Explorer	to”	as	“This	PC”	instead	of	“Quick	Access.”Optimize	Folders:	Right-click	the	slow	folder	>	Properties	>	Customize	>	Optimize	for	General	Items.Run	Disk
Cleanup:	Type	“Disk	Cleanup”	in	Start	and	remove	temporary	files.Disable	unnecessary	startup	programs	(Task	Manager	>	Startup	tab).Increase	virtual	memory	(Control	Panel	>	System	>	Advanced	system	settings	>	Performance	>	Advanced	>	Virtual	memory).3.	Missing	or	Disappearing	FilesSolution:Use	the	search	bar	in	File	Explorer	to	locate
files.Check	the	Recycle	Bin.Enable	hidden	files	(View	>	Show	>	Hidden	Items).Run	a	system	file	scan	(sfc	/scannow	in	Command	Prompt).Restore	previous	versions	of	files	(Right-click	file/folder	>	Properties	>	Previous	Versions).4.	File	Explorer	Keeps	CrashingSolution:Disable	unnecessary	startup	programs	(Task	Manager	>	Startup).Scan	for
malware	using	Windows	Security	(Windows	+	I	>	Update	&	Security	>	Windows	Security).Perform	a	system	restore	(Control	Panel	>	Recovery	>	Open	System	Restore).Create	a	new	Windows	user	profile	(Settings	>	Accounts	>	Family	&	other	users	>	Add	someone	else	to	this	PC).Advanced	Tips	to	Get	Help	with	File	Explorer	in	WindowsIf	basic
troubleshooting	doesn’t	solve	your	problem,	here	are	additional	methods	to	get	help	with	File	Explorer	in	Windows:1.	Use	Windows	TroubleshooterGo	to	Settings	>	Update	&	Security	>	Troubleshoot	>	Additional	troubleshooters	>	Windows	Explorer	>	Run	the	troubleshooter.2.	Reset	File	Explorer	SettingsOpen	File	Explorer	Options	(Control	Panel	>
File	Explorer	Options).Click	on	the	Restore	Defaults	button.3.	Run	System	File	Checker	(SFC)	and	DISMOpen	Command	Prompt	as	Administrator	and	type:sfc	/scannowIf	SFC	doesn’t	resolve	the	issue,	run:DISM	/Online	/Cleanup-Image	/RestoreHealthThis	repairs	system	image	issues.4.	Use	Windows	Support	and	Community	ForumsVisit	the	Microsoft
Support	website.Post	your	query	in	the	Microsoft	Community	Forums.Contact	Microsoft	Customer	Support	if	the	issue	persists.5.	Check	for	Windows	UpdatesKeeping	Windows	up	to	date	ensures	you	have	the	latest	bug	fixes	and	security	patches.Go	to	Settings	>	Update	&	Security	>	Windows	Update	>	Check	for	updates.File	Explorer	AlternativesIf
you	are	looking	for	an	alternative	to	File	Explorer,	consider	the	following	file	managers:Total	Commander	–	Advanced	file	management	with	dual-pane	interface.XYplorer	–	Portable	file	manager	with	tabbed	browsing.Directory	Opus	–	Highly	customizable	file	explorer	replacement.FreeCommander	–	Lightweight,	efficient	file	manager	with	dual-pane
navigation.ConclusionFile	Explorer	is	a	powerful	tool	in	Windows,	but	it	can	sometimes	encounter	issues.	If	you	need	help	with	File	Explorer	in	Windows,	try	the	troubleshooting	steps	outlined	in	this	guide.	Whether	it’s	fixing	crashes,	improving	speed,	or	finding	missing	files,	these	solutions	will	ensure	smooth	file	management	on	your	PC.
Additionally,	using	alternative	file	managers	can	provide	enhanced	features	if	you	need	more	flexibility.Read	Also:	File	Explorer	is	a	fundamental	part	of	the	Windows	operating	system,	serving	as	the	primary	interface	for	managing	files	and	folders.	Whether	you’re	navigating	through	your	documents,	seeking	specific	files,	or	organizing	your	digital
workspace,	understanding	how	to	effectively	use	and	troubleshoot	File	Explorer	is	essential.	In	this	detailed	article,	we	will	explore	various	aspects	of	getting	help	with	File	Explorer	in	both	Windows	11	and	Windows	10,	from	the	built-in	support	resources	to	third-party	solutions.	Understanding	File	Explorer	Before	delving	into	getting	help	with	File
Explorer,	it’s	critical	to	grasp	what	it	is	and	its	significance.	File	Explorer	(previously	known	as	Windows	Explorer)	allows	users	to:	Navigate	their	file	system	effortlessly	Organize	files	and	folders	Access	network	storage	Manage	cloud	storage	(e.g.,	OneDrive)	Share	files	and	folders	with	others	Knowing	how	to	utilize	File	Explorer	efficiently	can	make
a	considerable	difference	in	your	overall	user	experience.	Common	Issues	with	File	Explorer	While	File	Explorer	is	a	robust	tool,	users	often	encounter	issues	from	time	to	time.	Some	common	problems	include:	File	Explorer	freezing	or	crashing	Issues	with	search	functionality	Slow	performance	when	opening	or	navigating	folders	Problems	with	file
previews	and	thumbnails	Missing	or	corrupt	files	Understanding	these	common	issues	will	assist	you	in	targeting	your	troubleshooting	efforts	effectively.	In-Built	Help	Options	in	Windows	11	and	Windows	10	1.	Windows	Help	and	Support	Both	Windows	10	and	11	come	equipped	with	comprehensive	help	resources.	You	can	access	this	feature	by:
Pressing	the	F1	key	within	File	Explorer.	This	will	launch	the	official	help	documentation	in	your	default	web	browser.	Going	to	Settings	>	Help	to	access	additional	resources.	The	help	menu	includes	articles	related	to	common	tasks,	troubleshooting,	and	best	practices	for	using	File	Explorer.	2.	Quick	Actions	in	the	Toolbar	File	Explorer	features	a
Ribbon	tool	at	the	top,	which	includes	various	functionalities.	If	you	need	assistance,	look	for	the	View	tab,	which	allows	you	to	customize	your	file	management	experience.	You	can	enable	features	such	as:	Previewing	items	Enabling	hidden	items	Changing	folder	options	Taking	time	to	explore	these	features	can	enhance	your	understanding	and
efficiency	in	using	File	Explorer.	3.	File	Explorer	Options	If	you’re	facing	usability	issues	or	specific	quirks	in	how	File	Explorer	operates,	exploring	the	File	Explorer	Options	can	help.	Open	File	Explorer.	Click	on	the	View	tab	in	the	Ribbon.	Select	Options.	From	here,	you	can	modify	settings	related	to	how	folders	and	files	are	displayed,	tweak	file
path	behavior,	and	change	advanced	settings	that	dictate	how	File	Explorer	interacts	with	your	files.	4.	Windows	Search	Bar	The	search	feature	available	in	both	Windows	10	and	11	can	be	invaluable	when	trying	to	find	help	regarding	File	Explorer	issues.	By	typing	keywords	into	the	taskbar	search	bar,	you	can	quickly	access	articles,	forums,	and
even	settings	related	to	your	query.	5.	Windows	Feedback	Hub	If	you’re	encountering	issues	not	covered	in	the	help	resources,	consider	using	the	Windows	Feedback	Hub:	Press	the	Windows	key	+	F	to	launch	the	Feedback	Hub.	Report	your	file-related	issues	for	potential	fixes	or	workarounds.	This	tool	allows	you	to	see	if	others	have	similar
problems,	and	Microsoft	often	responds	or	issues	patches	for	common	conundrums.	Utilizing	the	Microsoft	Support	Website	Microsoft’s	official	support	website	is	an	excellent	resource	for	troubleshooting	and	getting	advice	related	to	File	Explorer	issues.	Here’s	how	to	navigate	it:	Go	to	support.microsoft.com	and	enter	“File	Explorer”	in	the	search
bar.	Scour	through	the	articles,	FAQs,	and	guides	available.	Use	the	community	forums	to	engage	with	other	users	who	may	have	faced	similar	issues.	These	resources	often	include	step-by-step	instructions	to	resolve	common	problems,	tips	for	optimizing	performance,	and	even	video	tutorials.	Community	Forums	for	Support	The	Windows
community	forum	is	another	vibrant	place	to	seek	help.	Here	are	a	few	steps	to	follow:	Visit	the	Microsoft	Community	page.	Search	for	your	particular	File	Explorer	problem.	Engage	in	discussions	or	create	a	new	post	if	you	cannot	find	an	existing	solution.	Community	members,	including	Microsoft	MVPs	and	avid	users,	often	provide	helpful	insights,
fixes,	and	shared	experiences.	Advanced	Troubleshooting	TechniquesUpdate	Drivers	→Fix	Your	PC	→	If	standard	support	does	not	resolve	your	File	Explorer	issues,	consider	advanced	troubleshooting	techniques.	1.	Running	the	Windows	Troubleshooter	Windows	includes	a	built-in	troubleshooter	to	help	identify	and	fix	common	system	issues,
including	those	that	may	affect	File	Explorer.	Go	to	Settings	>	System	>	Troubleshoot	>	Other	troubleshooters.	Locate	File	and	Folder	Troubleshooter	and	run	it	to	diagnose	any	potential	issues.	2.	Resetting	File	Explorer	If	File	Explorer	consistently	behaves	incorrectly,	you	may	want	to	reset	it:	Open	the	Task	Manager	by	right-clicking	the	taskbar
and	selecting	it.	Find	Windows	Explorer	in	the	list	of	processes.	Right-click	it	and	choose	Restart.	Resetting	can	often	clear	temporary	glitches	that	cause	performance	issues.	3.	Checking	for	Windows	Updates	Often,	issues	with	File	Explorer	can	stem	from	outdated	software:	Go	to	Settings	>	Update	and	Security	>	Windows	Update.	Check	for	any
available	updates	and	install	them.	Updates	may	contain	patches	and	fixes	that	resolve	existing	problems.	4.	Execution	of	System	File	Checker	Sometimes,	system	files	associated	with	File	Explorer	can	become	corrupt.	To	restore	these	files,	execute	the	System	File	Checker	(SFC):	Open	the	Command	Prompt	as	an	administrator.	Type	sfc	/scannow
and	press	Enter.	This	process	can	take	some	time,	but	if	it	finds	any	corrupted	files,	it	will	attempt	to	repair	them	automatically.	5.	Rebuilding	the	Search	Index	If	your	search	functionality	is	sluggish	or	unresponsive,	consider	rebuilding	your	search	index:	Go	to	Control	Panel	>	Indexing	Options.	Click	on	Advanced	and	then	select	Rebuild.	This
process	can	help	improve	search	accuracy	and	speed	in	File	Explorer.	Using	Third-Party	Tools	Sometimes,	Windows’	built-in	tools	may	not	address	all	your	needs.	When	that	happens,	third-party	software	can	provide	alternative	solutions.	1.	File	Management	Tools	Several	third-party	file	management	tools	offer	extensive	features	beyond	what	File
Explorer	provides.	Programs	like	Total	Commander	or	Directory	Opus	allow	for	multi-pane	views,	tabbed	browsing,	and	enhanced	file	preview	options.	These	tools	often	have	extensive	support	documentation	that	caters	to	various	user	needs.	2.	Cleaner	Software	File	Explorer	issues	can	arise	unless	your	system	is	adequately	maintained.	Cleaner	tools
like	CCleaner	can	help	tidy	up	unwanted	files	and	optimize	system	performance,	potentially	easing	problems	with	File	Explorer.	3.	Community-Created	Scripts	and	Tools	The	tech	community	often	creates	scripts	or	small	utilities	designed	to	enhance	or	troubleshoot	File	Explorer.	Websites	like	GitHub	host	numerous	projects	that	can	be	downloaded
for	specific	file	management	needs.	Frequently	Asked	Questions	(FAQs)	Why	does	File	Explorer	keep	crashing?Driver	Updater	-	Update	Drivers	Automatically	→	File	Explorer	crashes	can	often	result	from	software	conflicts,	corrupted	files,	or	plugin	issues.	Running	the	SFC	scan	or	resetting	File	Explorer	may	help.	How	can	I	troubleshoot	the	search
function	in	File	Explorer?	To	troubleshoot	search	issues,	rebuild	the	search	index,	check	for	updates,	and	ensure	your	Windows	settings	are	correctly	configured	to	allow	indexing.	Is	there	any	way	to	customize	the	File	Explorer	interface?	Yes,	you	can	customize	File	Explorer	by	changing	the	layout,	modifying	ribbon	options,	or	selecting	which	folders
display	in	Quick	Access.	What	should	I	do	if	I	can’t	find	a	file?	Use	the	built-in	search	feature	of	File	Explorer,	and	ensure	you	check	in	hidden	and	system	folders	if	necessary.	Utilize	external	search	tools	if	needed.	Can	I	repair	File	Explorer	without	reinstalling	Windows?	Yes,	running	the	SFC	command,	resetting	File	Explorer,	or	performing	a	system
restore	can	often	fix	problems	without	a	full	reinstall.	ConclusionUpdate	Drivers	→Fix	Your	PC	→	Getting	help	with	File	Explorer	in	Windows	10	and	11	encompasses	understanding	built-in	tools,	leveraging	community	resources,	and	using	advanced	troubleshooting	techniques.	From	engaging	with	Microsoft’s	support	to	exploring	third-party	tools,	a
wealth	of	options	is	available	to	enhance	your	experience	and	resolve	common	issues.	By	actively	utilizing	the	resources	and	techniques	outlined	in	this	article,	you	can	optimize	your	Windows	file	management	experience,	ensuring	that	File	Explorer	becomes	a	reliable	ally	in	your	daily	productivity	tasks.	Never	hesitate	to	reach	out	for	help,	whether
through	Microsoft’s	official	channels	or	user	communities,	because	effective	file	management	is	crucial	in	our	increasingly	digital	world.
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